B·A·T (Building Architect Tool)
-Essentials Tutorial
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Part 1
Introduction
Everybody was asking for it, so here it is. This is going to be an all-inclusive tutorial on the BAT that will take you from starting the model to getting the lot into SC4. I hope to establish all of the absolute basics you will need to create the building of your dreams, texture it, light it, export it, define the properties in the Plugin Manager, place it on a lot, and seeing it in game.
There will be a few of the more advanced features covered, but by and large this will be a basic tutorial for beginners. Below you will find the index of all pages (I divided each section into a different page to save page-load time for all those on dial-up, and to save my sanity when trying to organize this tutorial). This tutorial will cover a Commercial Building, but the lessons learned here could easily carry over to a Residential, Landmark, or even an Industrial Building. I chose Commercial as they are usually boxes, and it would be easier for me to explain to you (and for you to model) a rather simple building. Without further ado, I now present the tutorial.
Getting Started
(At this point, I am assuming you already have gmax, the BAT, the Plugin Manager, the new Lot Editor, and the SC4 patch installed on your system. If you don't yet, go get them now.)
Well, to begin any good tutorial, we'll have to begin at the beginning. In this case, we need to familiarize ourselves with the BAT/gmax. Firstly, open the BAT by double-clicking the "SC4 BAT" icon on your desktop.
NOTE: I refer to the "BAT" and "gmax" as interchangeable terms. In reality, gmax is the modeling program, the BAT is simply the pre-made Maxis lighting rigs and export tools (among a few other things). Just remember that if I say "the BAT" or "gmax," I'm referring to the same program.
Once you get the BAT to open, take a minute to look at the interface. It's broken down below:
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1. Command Panel - you'll be doing most of your creating from here. This is also where the "rollouts" everybody talks about are. I refer to this panel often, but I'll put screenshots to show what I'm talking about.
2. Main Toolbar - extremely useful shortcuts to the menu bar commands.
3. Bottom Bar - the two most useful things here are the X, Y, and Z boxes, as well as the "Snap" button (discussed later).
4. Menu Bar - just about everything within the BAT can be accomplished from here, but many are duplicated in other tool bars.
5. Bottom Bar #2 - all your zoom, rotation, and pan commands are here.
6. [bookmark: OLE_LINK2][bookmark: OLE_LINK1]Viewports(not numbered) - four different views are shown here. The default is top, front, left, and perspective, but you can customize them to show anything you want them to. If I ever say "start out in the left view", then I mean to use the Left Viewport when creating whatever I'm having you create.
Helpful Tips Regarding the Zoom, Pan, etc Controls:
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1. Zoom [image: 未标题-5.jpg] - with this button clicked on, you can left-click in a viewport and, by moving the cursor up and down, zoom in and out.
2. Zoom All [image: 未标题-4.jpg] - similar to the "Zoom" button, but it zooms all active views at the same time
3. Zoom Extents/Zoom Extents Selected [image: 未标题-3.jpg] - zooms the view out a fair distance (haven't been able to figure out the difference between the two selections yet--but I'm sure there is one).
4. Zoom Extents All/Zoom Extents All Selected [image: 未标题-2.jpg] - "Extents All" moves all active viewports out, "Extents All Selected" (when pressed) zooms in on whatever object(s) are selected.
5. Region Zoom[image: 未标题-6.jpg]- my favorite, allows you to drag a box into one of the viewports--when you let go of the mouse button, the view zooms into and re-centers on the box you created--the box is not an object.
6. Pan[image: 未标题-7.jpg] - with this button clicked on, you can left-click in a viewport and move the view around.
7. Arc Rotate[image: 未标题-8.jpg] - very fun to play with; with this button clicked on, you can left-click in the viewport and drag the view around to any angle your heart desires.
8. Min/Max[image: 未标题-9.jpg] Toggle - very simply, it makes the active viewport large enough to fill the area that all four viewports are currently occupying.
NOTE: Any button with a little arrow in the lower right-hand corner (look really closely at the picture above at buttons 3, 4,and 7) means that button has more than one option. If you click and hold the button, gmax will pop a little box above the button giving you all possible choices. Take note that all of the button choices are available, even the currently selected one.
Now you're going to want to make sure the units are set up correctly. The BAT does ship with these set up automatically, but it never hurts to make sure. After all, you wouldn't want to spend two days modeling your dream building and then realize the scale is way off, would you? Take note that with these settings, the grid lines that are shown will give you the SC4 scale. In other words, the lighter-colored "blocks" will be 1 meter on each side, and the darker-colored ones will be 16 meters on each side - or one tile in SC4.
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Customize>Units Setup
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Ensure "Generic Units" is selected.
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Customize>Grid and Snap Settings
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Home Grid>Grid Spacing 1.0 and Major Lines 16.
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Customize>Preferences
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System Unit Scale: 1 Unit= 1.0 meters
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Helpful Tip Regarding the Viewports
If you right-click on the viewport name in the upper left-hand corner, it will give you this menu. You don't necessarily need to worry about all the options, but the most important ones I will explain. "Wireframe" is the default view for the Top, Right, Back, and Left viewports. The "Other" option gives you additional display options (I'm not going to explain them all - you can experiment and see what they do). If you uncheck "Show Grid", the grid lines will be hidden - unless you really want to do this I wouldn't recommend it. The "Views" option will let you pick from all of the different available views (the only views you need to concern yourself with at this point are Front, Back, Left, Right, Top and Perspective - but you can choose to see your model from perspective of one of the cameras, or lights, or anything available). The "Configure..." option will take you to the same window as Customize >Viewport Configuration... You can play with that to see what it can do, but it's not really necessary.
How To Select Objects
[image: 未标题-1.jpg]
(Drag Select)

[image: 20200122230253.jpg]
(selected objects become highlighted in white)
1. Click on individual objects--using the cursor, click on individual objects in one of the viewports - if you hold down "Ctrl" on your keyboard, then you can click on multiple objects to select them (if you accidentally select something you didn't want to pick, simply click on it again with the "Ctrl" key still held down.)
2. Drag Select--hold down the left mouse button in a viewport and drag a box around the object(s) you want to select - when you release the mouse button anything within the box will be selected.
3. Select By Name--press the "H" key on your keyboard (this is know as a "hotkey") and it will give you the "Selected Objects" window (above right)--you can choose to hide things you don't want to see and use standard Windows list selections (discussed below) to pick from the list--notice that you can select by name (type what you're looking for in the blank box above the list), so name everything.
Windows Selection Methods "Shift" select - hold down the "Shift" key and either use the arrow keys or cursor to move up/down the list (you must have at least one object already selected in the list) - this is a "sequential" selection "Control" select - hold down the "Ctrl" key and click on names in the list - very useful if you want to select multiple objects that are not listed sequentially.

Quick and Dirty Guide to Basic Geometry Part 2
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(3d World) This is a rough approximation of the 3 dimensional world. Keep in mind that here, the 2d world (that of the X and Y axes - also known as "the ground") lays completely flat, but it retains the same grid point system. Unlike the 2d world, however, the 3d world also adds the Z axis, which moves up and down above and below the 2d world. This also adds another value to the point system.
Anytime you move "up" (above ground), Z is positive. Also, whenever you move "down" (below ground), is negative.
So, in this system, if you wanted a point that was 3 spaces to the right, 2 spaces back, and 5 spaces down, you'd represent it like this: (3,2,-5)
This is the world you will be dealing with in the Front, Back, Left, Right, and Perspective viewports.
[image: Introduction15.jpg]
Think about it like this: If you wanted to move a wall to the right, 8 meters, you'd make X = 8. If you wanted to move the same wall backward 16 meters, you'd make Y = 16. If you needed to move that very same wall 3 meters into the air, you'd make Z = 3. This example would also be expressed as: (8,16,3)
Keep in mind that even though the Front, Back, Left, and Right viewports look like the 2D world, they are in fact a flat representation of the 3d world. Don't worry too terribly much about keeping this completely straight - if you ever get confused, the little X, Y, Z thing in the lower left-hand corner of the viewport will remind you which way the axes are oriented. I hope this didn't confuse anybody, but I think at least this basic understanding of geometry is very important if you want to model in the 3d world. I'll try to explain it the best way I can as we go along, and it'll eventually become second nature to you.
NOTE: One tile in SC4 is 16 meters by 16 meters. This means that if you want your building to be a certain size, you will need to keep this in mind. For example, if you want the building to fit one a 2x3 tile, then it would need to be no larger than 30 meters by 46 meters (2 meters subtracted from each side as the Lot Editor does not allow overlap on buildings). Please keep this in mind as you are modelling--nothing is more heart-breaking than exporting your model only to find it's way out of scale. It is possible t scale the entire thing later, but that can become extraordinarily tedious and can be avoided by keeping this in mind at all times.
If you zoom out far enough in the viewports, the smaller "blocks" (the 1 meter boxes) will disappear and only show the larger "blocks" (the 16 meter boxes). This is very important to remember because when you first open the BAT, this is how the blocks will show (only the 16 meter boxes will be seen). If you model to the grid like this, you're building will be HUGE.
OK, enough preaching.
I was in the National Guard at one time, so my motto, like so many in the Infantry, is K.I.S.S. ("Keep It Simple, Stupid"). There is no need to make anything more complex than it has to be, and the simpler I keep something the better for my wee little brain. I refer to this concept often, so just forewarning you!
You're now ready to start modelling your building!
There have been many tutorials, explaining things in many different ways. It can become confusing. I tend to model with "extruded splines", so that's how I'm going to explain it to you. Hope it doesn't confuse anyone.
Before getting started, it's a good idea to sketch out your idea (or, if modelling from a real-life building, make sure to have plenty of pictures and facts about it available). I usually don't sketch anything out as I prefer for my building to grow "organically", but I will at least have a general idea in mind.
When I first began modelling, I always kept a notepad file open with the dimensions of everything I modelled. I know, that's very tedious and anal, but it really helps. Trust me, when you get part-way through a building and forgot how large the front windows are, or how wide that loading dock door is, or how tall the building itself is, you'll be kicking yourself for not jotting it down for easy reference. Besides, with more experience, you can always "eyeball" it later. I do NOT recommend eyeballing it when you are first starting out - you might be heartbroken later on when something didn't turn out exactly right (trust me on this - plenty of heartbreak here) and you'll spend a lot of time guessing at things and not actually modelling.
Let's get to it, shall we?
The building we're going to create, "BAT Tutorial, Inc", is going to fit within a 3x3 lot in SC4. Why 3x3 you ask? Well, because it's my tutorial and I can make whatever I want, and (even better) buildings scaled this size are small enough to be actual businesses without losing the details you're going to be toiling upon - oops, i meant "working on", Vu Industries slipping through there, sorry bout that! Besides, I think 3x3's are perfect for a small business (gives you plenty of room for detailing the lot - like parking lots, which take up an entire tile by themselves). The building itself will be 1 tile wide by 2 tiles deep. This means that it can't be any larger than 16 meters by 32 meters (don't worry, when you start modelling your buildings, you can fudge, and add a little here and there, just remember to not get too carried away or else you'll end up with a 12x12 before you know it!).
Do not "model to the grid" (in other words, don't base your building on the grid lines you see when you first open the BAT). When you first open the program, the viewports are zoomed out far enough so that each box is 16 meters square instead of 1 meter. Don't say I didn't warn you.
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We're going to create the front wall first. To do this, we're going to create a rectangle by clicking the "Splines"button, then clicking the "Rectangle"button. The cursor will turn into a cross-hair when you move into the viewport (gmax is telling you that you can now create a spline). Within the "Front" viewport, click and drag a "box" of any size (do not get all caught up in creating the perfect size right now - it can more easily be changed after creation). Now, gmax will helpfully name it "Rectangle01" and give you the current size in the "Parameters" rollout. Since this building will fit within a 1x2 box in SC4, we'll need to resize it. MaxisBrian suggested that to model buildings with "normal" ceilings to make the walls 4.5 meters tall. Since this will be a business, and most businesses have taller ceilings (not to mention it makes everything nice and even), change the Length to 5 and the Width to 16. Since the settings are correct, any number you type in a box like this is already set to "meters". That's what was meant by "1 Unit = 1.0 meters".
NOTE: The BAT will create the object directly on top of whatever axis you're looking directly towards. So, if you are in the "Front" or "Back" viewport, the object will create with it's Y coordinates at 0. If you're in the "Left" or "Right" viewport, then it will created with it's X coordinates at 0.
At this point, you will need to rename your object. I have my own particular naming scheme of object type-object name. This way, it's much easier to find by name later (if you're looking for the left wall, you'd go down the list until you find "Wall - Left"). You can also define it's color if you'd like. It's not too terribly important, but it can help the object stand out (and give you an idea of your color scheme for later). This object will be named "Wall - Front".
NOTE: I can't stress this enough: NAME EVERYTHING. Even if you don't feel like it, even if it's too hard. For the sake of your own sanity, give everything a name. You'll thank me later when you have literally hundreds and hundreds of named objects to sift through to find that front door frame.
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To keep everything as simple as possible, it's best to move your rectangle so that it's centered. Select your rectangle (click on it in the "Front" viewport - unless it's already selected), then click on the "Select and Move" button. Now, make X = 0, Y = 0, and Z = 2.5. Whenever you move something around in this manner, it's helpful to remember that this will move the object relative to it's center (with a few exceptions, but I'll mention those if and when it comes to those objects) - meaning that these coordinates put the center of the rectangle at zero on the X and Y axes, and 2.5 meters in the air. Didn't ya just know all that math you learned in school would be good for something one day? Don't worry about the "building needing to be centered on X and Y for export" at this point - it's very simple to do later, and this will make modeling much easier for you.
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TIP: When you're moving things around, sometimes the objects will get out of view. You can easily re-center the viewports on the selected object by hitting the "Zoom Extents all Selected" button.
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Now, we're going to create a door. Simply create a rectangle in the front view (since the wall is sitting directly on the X axis, the door is already sitting in the wall) and adjust it's Length and Width like so. The settings for this door are not exactly to scale, but this makes a good-sized doorway for a double-door, or an entrance into a foyer. Notice I didn't change the name or color of the object? I'll explain in more detail later, but trust me, it's not necessary. Now, using the "Select and Move" button and the X, Y, and Z boxes, move the door to X = 0, Y = 0, and Z = 1.8 (this centers your door on the wall and makes it 0.2 meters off the ground - half the door's height plus the 0.2 meters). I trust that you know what that'll look like, so I won't post a screenie.
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Now, we're going to make windows for this wall. Still in the front view, create another rectangle and set the Length and Width thusly. This one is also probably not to real-world scale, but I think it'll look nice when all's said and done, so there. LOL. (Not to mention the fact that it will make everything much simpler.)
This is where the settings for the grid come in really handy. Notice I made the window exactly two meters wide? Using the grid behind it as a reference, click on the "Select and Move" button to line it up with the grid lines like below:
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Notice how the X and Y arrows have changed? Y will always show as a green arrow, Z as blue, and X as red (unless there's some place I overlooked that lets you change their colors). If you hover the pointer over them, the bar below/beside the point will turn a different color, indicating it's "active". When this happens, you can left-click and hold, then any movement you make will be restricted to that axis. In other words, the way it is now, no matter which way I move the pointer, the object will only move up and down. Very, very useful. This is true regardless of the viewport you're currently in, including "Perspective".
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What kind of office building would it be with just one window on the front wall? To fill in the remaining space, you'll need to make more windows. There are at least two different ways that I know of. "Array" (the button that looks like a dot with several spheres around it in the Main Toolbar) and "Clone". It's not necessary to array here, as there are so few windows (but I will get into the Array tool sometime later). What you're going to want to do is "Clone" your existing window to create an exact copy.
There are two ways to accomplish this. From the Menu Bar, you can go to Edit & Clone (sometimes very useful), but that creates a copy directly on top of the existing shape. The easiest way to make a clone in this example is to hold down the "Shift" key on your keyboard, then drag the rectangle (it helps to use the movement technique described above for this so you don't have to re-align your windows vertically). Take note that there will be the outline of the new object while you move it. When you release the left mouse button, gmax will give you the window below.
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Don't go and get all click-happy here, you have an important choice to make. If you choose to click the radio button next to "Copy", then the new object will be an exact duplicate of the object selected. If you click the radio button next to "Instance" then it will also be an exact duplicate, but any changes you make to the original also affects all instances (copies) of it. In other words, if later you decided this window should be 1.5 meters wide instead of 2.0, then you only have to change the original and not each and every single one. Extremely useful for a large project.
You also have the option to make more than one copy, but I wouldn't recommend doing that unless you really, really want to. Also, if you choose to, you can change the suggested name that gmax gives at this point. After all those decisions are made, simply click "OK" or hit the "Enter" key on your keyboard and your copy is created. Conversely, if you hit "Cancel" or the "Esc" key on your keyboard, the action is cancelled and no copy created.
You don't have to make all of the windows copies of the first one. Unlike the real world, it doesn't hurt to make a copy of a copy of a copy of a copy... You can simply clone the last object you placed so you don't have to click and drag all the way over to the other side. Did I mention I'm also lazy?
TIP: It might be useful at this point to make a clone of one of the windows and put it off to the side. Since these windows are simple rectangles, you don't absolutely have to, but it will save you from having to create it all over again later on...... I did mention I'm lazy, right?
Got it so far? Ready to go on? Good. Now we're getting into the fun stuff.
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[bookmark: OLE_LINK3]The first thing you're going to want to do is "collapse your object to an editable spline". Huh? What did I say? Don't worry, that blank stare you probably have right now is exactly how I felt the first time I saw that in print. To do that, select the "Wall - Front", go to Modifiers Patch/Spline Editing Edit Spline. The Command Panel will change to this:
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Whoa! There's a whole lotta stuff there, huh? Don't worry, most of that is not anything you need to concern yourself with (at least, not until you get closer to claiming "expert" status on the BAT). The only two buttons you need to concern yourself with right now are "Attach" and "Attach Mult.". If you click on "Attach", then you can go into one of the viewports with the pointer, which will turn into a funny-looking cross hair with bubbles around it (can't get a screenshot of one, but if you try it you'll definately see what I'm talking about,) when you hover over an object. That can be very useful, but a little tedious. Instead, we're going to click on "Attach Mult.", which gives us the next window:
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[bookmark: OLE_LINK15][bookmark: OLE_LINK16]From here, you'd select the splines you want to attach. Notice I didn't pick "Rectangle06"? All that we want to attach to this wall is the windows and doorway. Rectangle06 is the last copy I made of the window and put off to the side. If you attach it, strange things will happen when we get to the next step.
- Be sure not to attach it. -
Once you have everything selected, click the "Attach"button or hit the "Enter" key on your keyboard.
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*Poof* The BAT has now made all of your other objects a single object. This is why renaming the windows and doorway was unimportant before. Since they have all now become one object, they will take on the name and color of the spline with the "Edit Spline" modifier on it. At this point it might be wise to rename the extra rectangle as "Windows - Opening".
That wall doesn't look very much like a wall, does it? We'll take care of that in the next step.
TIP: If you're ever confused as to which direction X, Y, and Z are (they are constants, but in a 3D environment such as this, it's easy to get turned around), the little bugger in the corner of the viewport helps tremendously. It shows you which axis is which in the current view. Take note that is independent of the X, Y, and Z displayed with the "Select and Move" tool - those are dependent on the view that you're in. This is because for "Select and Move", the orientation of X and Y is based on the object and not the real world. A little confusing, I know, but play with it for a few minutes and you'll see what I'm talking about.
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Now you want to "slap an Extrude Modifier on it." Basically, go to Modifiers> Mesh Editing>Extrude.
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Surprised you, didn't it? Shocked me when I first saw it, too. No worries, though, all you have to do is change the "Amount" to something more appropriate. To give your walls some "depth", my suggestion is 0.3 - in real-world terms this means that your wall is 0.3 meters thick (or for we Americans who *refuse* to learn the metric system, that would be 0.98 feet - but because I'm lazy we'll just call it 1 foot). I know what you're going to say - "But phillippbo, we're not making a bunker, we're making an office building. Why is it so darn thick?" Simple. In SC4, there are some things that need to be exaggerated or else they don't show very well. Trust me on this one, 0.3 is a minimum for wall thickness.
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Congratulations! You have now successfully made the front wall with it's appropriate openings. Now, go to File > Save As... and save your model. With all the horror stories I've heard about the BAT, make sure you save it often. It might not be a bad idea to also save several copies (put one on your desktop, on a diskette, or if you have a burner onto a CD-R). This way, if something goes all buggy and your file becomes corrupted, then you don't lose but so much work.
I save all of mine in the "gmax/Scenes" folder instead of the "gmax/gamepacks/BAT/scenes" folder. Some people have mentioned that their files have become corrupted saving them in the BAT/scenes folder, and none of mine have yet, but you never can be too careful!
Creating Walls B - "Completing the Building"
Now that you've got the basics down for creating wall with extruded splines, we need to round out our building. Some people model one complete wall at a time, which is fine if you're modeling after a real-life building. I'm not saying there's anything wrong with that. This is not how I model, however. I think it's best to get the basic shape down, then add detailing to it later. Alrighty then - are we having fun yet?
[image: createwall1.jpg]
As you'll recall from before, this is where we left off. We're going to need to make some more walls! I'm going to make the back wall next. You actually have two choices here: create an entirely new wall or clone the existing wall and move it back. For the sake of simplicity, I'm going to clone the front wall.
[image: createwall2.jpg]
Since I already know how far back I'm going to move the wall, I'm not going to use the "Shift/Clone" method. Instead, I'm going to use "Edit > Clone" method. You get the same clone window, but this time it's important to pick "Copy" instead of "Instance". This will become important in a few minutes. Be sure to rename your wall "Wall-Back".
[image: createwall3.jpg]
To move your wall, we'll use the "Select and Move" button. It is not necessary to select your new wall is it will already be the wall selected. Make Y = 32 and hit "Enter" on your keyboard. Your wall will now be moved back 32 meters.
Note: Notice how the grid lines become darker every 16th box? This is one reason it's very important to make sure the settings in the BAT are correct. With it like this, you can easily see the scale of your building because each darker box represents one tile in SC4. (I zoomed out in the top viewport to show you.) See how the front wall extends out from the X axis instead of going behind? This is not too terribly important but to keep with my K.I.S.S. theme, I'll show you an easy way to fix that. First you'll need to select "Wall-Front". Then you'll need to change the Extrude modifier... wait a sec. What?
[image: createwall4.jpg]
Seems that all of our options are gone. I guess we'll just have to create the wall all over again....
.....unless you want to use the method below:
[image: createwall5.jpg]
change extrude (offset) to -0.3
In the Command Panel, click on the "Modifier" tab. This is actually where most of the rollouts you'll be working with are. Now we can see our extrude amount and change it. Remember how our wall extended out from the X axis? It's a quick fix, simply change the extrude to -0.3 so that the extrude reverses itself.
[image: createwall6.jpg]
Whew, that was a close one. Don't even have all four walls up yet and already having problems.
I don't really think that I want the back door looking exactly like the front, so we're going to change this. Remember this is only one way to do it, but if I tried explaining every single possibly way to do something this tutorial would have never been finished.
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The front wall is going to be in our way. You could simply move it, but then you'd have to move it back. I'm lazy and don't want to go through all of that trouble. Instead, I'm simply going to hide it so it's not getting all in my way. Do this by selecting "Wall - Front" and right clicking. It gives you the above menu. You can do many, many things from here, but we're simply going to use the "Display" functions (the greenish color). If you pick "Hide Unselected", everything but the currently selected object will disappear from view. That's not what we want, so we're going to pick "Hide Selection" so that the front wall will disappear from view. (I'm sure you can picture what this will look like - so no screenie for this either - you don't really want me to burn out my copy of Fireworks, do you?)
[image: createwall8.jpg]
[bookmark: _GoBack] (
go to Modifiers Patch/Spline Editing Edit Spline
.
)

To make changes to the existing object, we'll need to edit it. Select "Wall - Back" and go to the Modifier Tab. In the modifier list, click the plus beside "Edit Spline" to display the edit spline rollout. Select "Segment" so that we can move the sides of the rectangle around (notice you can also use the buttons in the "Selection" rollout below). If you choose "Vertex" you can move individual vertices (corners) of objects around and "Spline" lets you move entire rectangle around.
Now, the back wall should look like the above picture (sorry about the lack of white lines around the edges of the wall in the front viewport - happened when I resized the picture). Using the "Select and Move" tool, you can either eyeball it (ugh), or you can type values in X, Y, and Z. Since I'm going to make this door narrower, I'll pick the right-hand side of the doorway (whichever segment, vertex, or spline is currently selected will show in red) and in the X box replace 1.25 with 0.75. Now, select the opposite side of the doorway. Notice the value for X is now -1.25? Geometry, gotta love it! This time, replace the -1.25 with -0.75. This makes the door 1 meter narrower - perfect for a single door. Now, you'd click on "Extrude" in rollout to finish editing your object: [image: 未标题-5.jpg]
[image: 未标题s2.jpg][image: Imagem]
You can now unhide your wall (right click in the viewport and pick "Unhide All") and zoom backout to see your creation.
The next step is to create the side walls. Again, there are many ways to do this, and I'm only going to explain one of them. Create a rectangle just like you did for the front wall, but this time do it in the left viewport (to get back to where you can create a spline, pick the create tab - directly to the left of the modifier tab - and click on the splines button):
[image: createwall10.jpg]
Don't forget that we're going to have to re-size this wall (make the settings like above - the walls are 5 meters high and the building is 32 meters long - still have your notepad file open?). Rename the wall as "Wall - Left". Also, don't forget that this wall is sitting directly on the Y axis. Using "Select and Move", change it's position thus.
I'll explain the X, Y, and Z to make sure you understand why we're setting them like this (remember that when using typed-in values like this X is always side to side movement, Y is always front to back movement, and Z is always up and down movement). If you really don't want to know why and just want to keep modelling, skip past these next few screenies.
[image: createwall11.jpg]
First of all, we need to move the wall out to the where it should be on the left-hand side of the building. Since the center of the wall is sitting at point 0 on the X axis, we'll need to move it left by half the length of the front wall (the front wall is 16 meters wide, so we need to move the side wall 8 meters). Remember my quick guide to geometry on the "Getting Started" page? Because we're going to be moving to the left of the origin, X would be negative.
[image: createwall12.jpg]
Next, we'd need to line it up properly with the front and back walls. Since we are moving the wall backward and going above the origin (in the 2d world), we would change Y to be a positive number. Since we're moving the middle of the wall halfway between the front and back walls, Y = 16. Lastly, just like the front walls, we need to put the wall so that it's sitting on the ground, so Z = 2.5.
Jeez, that math can really get tedious, huh? Don't worry too terribly much if you don't get it right now, I just wanted to put that information out there to try to help everybody understand why the system is the way it is. Take a breather, you need it!

 (
That Window
)[image: 未标sd题-2.jpg][image: createwall13.jpg]
Moving right along, remember that window I had you clone way back on the last page? You'll find out why it's important now. Instead of having to create new windows, all you have to do is pick your window (you don't need to make another copy of it - this is what we needed it for) and rotate it 90 degrees. To accomplish that, press the "Select and Rotate" button, then type 90 in the Z box. Remember, if you put a negative number here, the object will rotate clockwise. If it's a positive number, it'll rotate counter-clockwise. For this object, that's not important at all (but it will be important if you are going to rotate 3d objects). Also, if you move the pointer over one of the arrows, it will turn into a circular arrow. Just like with the "active arrow" method on the last page, these arrows will also change colors when they are "active". When the arrows are active, you can left-click and drag the pointer up and down to rotate manually. Very useful when trying to get perfect alignment, not so useful when you're trying to rotate by an exact amount.
[image: createwall14.jpg]
Remember the tip I gave you on the last page about the "active arrow" movement (where all movement is restricted to whatever arrow is colored differently)? This is where it can come in handy. Make sure you select the "Select and Move" button - otherwise you will rotate the window when all you want to do is move it. With that method, the only thing you will need to do manually is move the window - opening back until it lines up with the grid just like on the first wall.
"But, phillippbo," you ask, "it's still way out from the wall. I thought you said that'd do weird things when it comes to extruding?" You are very correct. What you will need to do now is type the same value for X that you have for Wall - Left (-8.0). Now the window is sitting perfectly on the wall.
[image: 未标题-e4.jpg]
Ok, so at this point you have a side wall with one bitty little window in it. That just won't do. You could use the same method we created the front windows, but there's gonna be so many of these. I'm so lazy, I don't want to do that. Instead I'm going to use a handy little tool called "Array". Make sure that you are in the Left viewport, and, with the window opening selected, click the "Array" button in the Main Toolbar. It will give you the window above. Now enter -3.0for the X boxbeside the number one, make sure that the radio button is selected next to 1D, and make sure the "Count" boxes are like shown. You'd then hit "Enter" to change the "Total in Array" box or OK to create the windows. Take a look at the "Total in Array" box (number 5). This will tell you how many objects you are cloning, and can be extremely useful.
NOTE: Just like with the Clone tool, you can choose to make copies or instances here.
Numbered items 1 and 4 are all that we are worried about right now, but I'll explain all of them (for items 1 through 3, only worry with the "Incremental" column for now):
NOTE: "Array" is one of the tools where X and Y are no longer constants in "real world" terms (like my geometry lesson) and are based on the viewport that is currently active. Based on the view that's active (as far as gmax is concerned, that's your "perspective"), X will always move left (negative numbers) and right (positive numbers) and Y up (positive numbers) and down (negative numbers) when you're using 1D cloning. It's a little much to explain here, but 2D cloning is a bit different.
1. Move - indicates how far you want each copy to move - based on the object's side. For example: if you had a square that was 3 meters wide and you wanted each one to be 1 meter apart, then you'd enter 4 here.
2. Rotate - tells gmax what kind of "spin" you want to give the cloned objects. Haven't played with it much, but it can be very useful if you master it.
3. Scale - indicates how much you want to scale the cloned objects. The number you type in here is a percentage. For example: if you wanted each copy to decrease in width by 25% each time it was copied, you'd enter 75 in the X box (you're telling gmax that you want each copy to be 75% of the width of the previous copy). Can be very useful, but I haven't found a use for it yet (at least, not in any of my buildings).
4. Array Dimensions Box - how many copies you want to make. For 1D, it's how many you want created across (in this case, we're making 10 windows). For 2D, it's how many up/down. And 3D does some interesting stuff (I over-simplified what 2D does - but that's not important right now).
Don't worry if the above seems a bit much. It took me about a week of playing with the "Array" tool before I could figure out what it did. I've only given you a basic idea of it's function here, it's a very powerful tool that could be a tutorial in and of itself.
Enough of that, on with the tutorial!
[image: createwall16.jpg]
Now you have your 10 windows going back along the wall.
Whoa there, partner! See that unsightly gap at the back? Normally, I'd go through the effort of playing around with the window's width or the array distance until I got it pretty darn close to perfect. Since I'm trying to keep everything as simple as possible, however, we're just going to leave it. Besides, I can use that to show you an important lesson later. What you'd do now is put an "Edit Spline" modifier on "Wall - Left",attach all of the windows, 
[image: 未标题qwe-2.jpg]
and extrude by -0.3 (this prevents the wall from extruding out from its current position). Then, you'd clone an instance of your wall and put it on the opposite side (change X to 8.0 and change your extrude to 0.3 to make the wall extrude inward instead of outward). Don't forget to rename the new wall "Wall - Right". You should now have this:
 (
I made a “Copy” here
,
 not an “Instance”
)[image: ]
[image: 未标we题-1.jpg]
Don't worry about all that silliness at the corners where the color is bleeding over. As long as you use the same texture for the side walls as the front, that shouldn't show. Congratulations! You now have four walls with all the appropriate openings.

Important Detailing: Windows, Doors, and the Roof
So, now we've got four walls, but we're far from done. Now, we're going to add some details to make our building begin to look like an actual building. I'm going to start with theroof.

[image: important1.jpg]
In the top view, create a rectangle of any size, then adjust it's length and width like shown (this will make it the exact same dimensions as the building without having to make hairy adjustments - see, It's a Good Thing™ that I had you make sure the walls extruded the way they did). Now, to center it, set X and Y like shown so that the middle of the rectangle is moved to the center of the building. Just like we did for the walls, place an Extrude Modifier on the rectangle and set it to 0.3. Since we want this to be on top of the wall, make Z = 5. Rename the rectangle "Roof - Surface".
[image: qw题-1.jpg]
[bookmark: OLE_LINK4]Farther down the page, I'm going to show you how to make transparent glass. Because the windows will be transparent, we're also going to want a floor in this building. To do this, make a clone of the roof, rename it "Foundation - Floor", and make it's Z = 0. You'll end up with the picture below:
[image: q未标题-1.jpg]
Next, we're going to make doors. For this step, it's very helpful to hide anything you're not working on. Since we'll be working on the front door, select "Wall - Front" and "Hide Unselected".
Next, you going to want to turn "3d Snap" on. It's actually pretty simple to do this, click the button shown below.
NOTE: The 3d Snap button has more than one option: 3d Snap, 2.5d Snap, and 2d Snap. The only ones you'll be worried with are 3d and 2.5d. See the picture below for an explanation about their differences (just remember that if you hold down the mouse button, a little window will pop up giving you the different options).
[image: ]
[image: important3b.jpg]
Click the "3d Snap" button down near the Z box, then go to "Grid and Snap Settings" (Customize >Grid and Snap Settings...) and pick "Vertex". There's a lot of options in this window, and most of them are self-explanatory. Just be sure that when you close this box that you use the "x" in the upper right-hand corner. Do not click the "Clear All"button unless that's what you really want to do (don't laugh - we've been trained by Windows to hit "OK" or "Cancel" inside windows like this - it's very easy to hit it without thinking about it).
[image: important4.jpg][image: important5.jpg]
When you create geometry with the 2.5d Snap on, it does line it up with whatever you were "snapping" to, but gmax creates the shape on the X or Y axis (depending upon which one you're looking directly towards). With 3d Snap on, gmax does the same thing, but this time places the vertices of the rectangle directly on top of the ones you are snapping to. Don't worry, I'm going to show you "snapping" in more depth below, just remember that 2.5d puts it on the axis, 3d puts it on the object.
Back to creating the front door.
[image: important6.jpg]
After you click the "Rectangle" button, and before you actually create the object, go into the "Mesh Settings" rollout (you will probably have to click the "+" symbol next to the name) and check the two boxes shown. These boxes will make sure that the rectangle you create will not be a simple rectangle, but will be rounded like in the 2.5d and 3d Snap pictures above. The default thickness is 1.0, but we definitely don't need a shape that thick (or else nobody would actually be able to fit through the door). Change the thickness to 0.3. A little note about the "Sides" option. The way it's set now, the "tube" that makes up the sides of this rectangle will have 12 faces. If you are going for a rounded look, you'll need to put at least 10 in here. If you're looking for something a little more squared-off, then anything less than 6 will do nicely, but there is a minimum of 3 sides (it takes at least 3 faces to make a 3d object). Don't worry, if you put anything smaller than 3 here, gmax will change it for you.
[image: important7.jpg]
In the front view, move the cross-hair around until you get a blue cross on the top-left corner of the door opening. Gmax is now telling you it's going to "snap" to that vertex.
[image: important8.jpg]
Drag your rectangle until you get the blue cross on the lower right-hand corner of the door opening, then release the mouse button. Rename the rectangle "Doors - Frame Front".
NOTE: Anytime that I say "snap a into ", I'm talking about doing what I just showed you.
Lastly, we're going to give this frame the illusion that it's actually a door frame and not some kind of decorative piece. In the top view, zoom in on the door opening and drag the door frame backward until it's outside edges line up with the front and back faces of the wall.
[image: ]
[image: important9.jpg]
VERY IMPORTANT NOTE: In order for any geometry created like this (by clicking the two boxes) to show in the final render, you will have to "collapse to an editable mesh". (Go to Modifiers >Mesh Editing >Edit Mesh).
[image: important10.jpg]
Now, to create the door for this wall (there can be many ways to do this, I'm just going to show you a very simple way right now), repeat the above steps (you may want to hide the door frame so the rectangle doesn't try to snap to any of the verticies on the frame - just don't forget to "Unhide All"after you're done with the door itself), but this time be sure to uncheck the "Generate Mapping Coord." and "Display Mesh"boxes after you've created the new rectangle (make sure your door frame is not selected when you do this) so it will be a simple rectangle. In the top view, you'll want to move your new door so that it's centered (front to back) in the frame - with 12 sides on the frame its really easy - you'll see what I'm talking about.
[image: ][image: qwqw未标题-2.jpg]
Rename the rectangle "Doors - Front".
[image: ]
Be sure to add an Edit Spline modifier to the door (that way, it's easier to change later). This isn't completely necessary at this point, but it would be a good idea to go ahead and put a UVW Map on this rectangle (Modifiers >UV Coordinates >UVW Map). We aren't going to be texturing it just yet, but when you put the map on it, the door itself gets "filled in", like so:
[image: ]
The next thing to do would be to create windows. Just like I said before, there are many, many ways to accomplish this. For the sake of K.I.S.S., I'm showing you one way.
[image: important13.jpg]
First, you'll want to snap a rectangle in the window just like we did for the door frame, but this time we'll only have the thickness set to 0.2. Why, you ask? Simple, how many window frames have you seen that are the same thickness as door frames? (Don't answer that, I'm sure you could prove me wrong.)
Rename the newly created frame "Windows - Frame".
[image: important14.jpg]
Next, we're going to create a spline line to act as the "divider" between window panes (you know, where the lock always is). The easiest way to do it is snap a line across the top of your window opening (you may want to hide the frame so that you don't have any trouble - just "Unhide All" when you're done with the line). Keep in mind that when working with lines, unlike most other shapes, you don't click and drag. Instead, you only click when you want gmax to put in a vertex. Therefore, be sure to click when the "blue cross" comes up for each of the top corners of our window opening. Since gmax will let you put in limitless verticies, it will have the next vertex showing, ready for clicking and placement. To avoid making any more verticies, hit the "Esc" button on your keyboard.
Don't forget to "Unhide All" to allow the window frame to show, if you hid it before.
Next, move the new line down until you get it where you want it (it is OK to eyeball here).
[image: important15.jpg]
Now that you have the line in place, put an Edit Spline Modifier on the "Windows - Frame"and attach your line (just like we did when we attached the window and door openings to the walls). 
[image: ]
[image: ]
[bookmark: OLE_LINK11][bookmark: OLE_LINK12]It will now become one object. Don't forget to add an Edit Mesh Modifier to your complete window frame, or else it won't show in the render. Make sure you do that now because you'll kick yourself if you don't. This building is only going to have 28 windows, but a medium-sized office building could have hundreds - meaning a lot of tedious work for you later if you don't take care of that now. Just warning you (trying to save everybody some of the heartache and pain I've gone through). Ok, ok, enough of the preaching. The next thing you'll need to do is snap another rectangle (again, hiding the window frame can be useful) in the same opening, uncheck the "Generate Mapping Coord." and "Display Mesh" boxes after the new rectangle is snapped, apply a UVW Map to it, and rename …… ▁▂▃▄▅▇(Plus Begin)this rectangle "Windows - Glass." Don't forget to “Unhide All” to make your window frame appear.
Then you can use the Hot key “H” to select both the “Windows – Frame” and the Windows - Glass. After you click the “Select” button, Choose From the menu “Group”>Group, Name the group "Windows" and click "OK." to confirm.
[image: ]
[bookmark: OLE_LINK14][bookmark: OLE_LINK13]As we have done before with the Door, (from the “Top View”) you can adjust it by moving your new group back to the wall until the back of the frame aligns with the back of the wall. Then we can use the two clone methods which Phillippbo had shown before(Shift and Drag or Clone from the menu), clone your windows one by one, likewise, align them as usual(It's up to you whether you want to manually name your clones.  For the purposes of this tutorial, we will use the Gmax default name.):
[image: ]
[image: ]

Now we need to add those the Windows(Group) onto the other sides of our model, Remember That Window(Rectangle06 was the last copy we made of the window which we put off to the side), To add them, I suggest using the same methodology we used previously, make one extra copy and put it aside for later use.
[image: ]

Next go to the left viewto view the left wall, We can also utilizerotate and align as we did with the front, Nowuse the Array tool to create other windows with X Move-3.0
[image: ]

Now Let’s go to the back side
[image: ]
NOTE: You can use [image: 未标题-8.jpg] Arc Rotate or use “H” select and [image: 未标题-2.jpg]”Zoom Extends All Selected” in Perspective view for a good better view, If you make a mistake or error, don't worry, as Ctrl+Z allows you to undo your action.


Becausethe glass on our window is UVW mapped onto one side only, we will need use Z rotate to rotate it (clockwise or counter clockwise). E.g.:
[image: ]
[image: ]
Next to create the rear door we follow the same method that Phillippbo taught us for the front door. Name the frame "Doors - Back Frame" and "Doors - Back"
[image: ]
[image: ]
Now let’s finish the last part of today, continue cloning and grouping to fill in the blank section of right side wall with windows.
[image: ]
Note that when I used the array tools here, I made a mistake with X = -3.0, Because we are doing an array copy from another side of the building, use as shown aboves: X=3.0
[image: ]

Don’t forget to save your work. When I followed this tutorial step by step, I kept on saving all as Phillippbo suggested. This way, you have multiple versions to revert back to, if need be.
[bookmark: OLE_LINK27][bookmark: OLE_LINK28]I guess that should be the end of Part1, May I quote from The Bible to congratulate you:
“Then God saw everything that He had made, and indeed it was very good.”
▁▂▃▄▅▇(Plus End)
Part 2
Finite Details - Foundations, Decorations, and Overhangs:
So now we have a pretty basic building with windows and doors. Looking better, but not complete yet, huh? The first thing we're going to want to add to this building is a foundation, or, well, the illusion of one. It's been my experience that most commercial buildings have concrete slab foundations, so there is no need to raise the building into the air. Instead, we're simply going to put a base around the bottom to simulate building decorations I've seen quite a bit in real life.

[image: finite1.jpg]

To start with, make sure you are on the Create tab, then click on the "Geometry" button. Next, you'll need to click the "Box" button. The difference between geometry and splines is that splines are two-dimensional (flat) shapes, while geometry are three-dimensional shapes. In the left view, create a box of any size (just like you created a rectangle, but instead of just dragging the box, you'll now also have to move the mouse back and forth to give it some depth - pay attention to your front, top, and perspective views to see when you've accomplished this). Good, but "Houston, we have a problem." Now we've got a nice little box (or nice big box, depending upon how large you made yours). It's also probably not in the correct place. Welp, we're going to fix that.

NOTE:This is one of those shapes where gmax doesn't move it based on the center. Instead, gmax will move it based on the "top" (the initial rectangle you created for the end). Just like the Extrude Modifier, you can reverse the direction of this box by making the height negative.
[image: finite2.jpg]
To make something that will show up well in SC4, but isn't overwhelmingly huge, change the parameters of the box like shown. Because this box was created in the left view (and gmax recognizes the initial rectangle you made as the "top"), the length is top to bottom, the width is front to back, and the height is side to side (in the 3d world). How did I arrive at 7.25 for the height? Simple (do you still have that notepad file open?). We don't want the foundation to cross in front of the door because it would partially block it, and I'd be willing to bet that would violate some Sim City Fire Codes. To remedy this, we'll need to figure out the distance from the edge of the doorway to the end of the wall.
The door itself is 2.5 meters wide, and the wall it sits in is 16 meters wide. Subtract the width of the door from the width of the wall and divide by two.
16 (wall) - 2.5 (doorway) = 13.5 / 2 = 6.75
We're not finished with the math yet. Since this foundation decoration is going to go all the way around the building, and we don't want unsightly corners (and to save a little bit of hairy fixing later), we also need it to let it stick off the end half a meter. (The box is centered within the wall, so half of it is sticking out the front. Since the box is 1 meter thick, it will protrude 0.5 meters from the wall.) Because we're going to place it exactly even with the edge of the doorway, we're going to need to add half a meter to the length of the box so that it sticks off the end 0.5 meters.
6.75 (distance from edge of doorway to edge of wall) + 0.5 (how much it'll stick out) = 7.25
The X, Y, and Z were pretty easy to figure out. The wall is sitting exactly on the X axis and protrudes back into the building, and we want the box centered within the wall, so we make Y = 0 (remember, this will be moving it front to back, so we change Y). We also want the box sitting exactly even with the edge of the doorway, which is 2.5 meters wide. Because the door is centered on a wall that is also centered (it's midpoint is sitting on the origin), then we take half the width of the door (1.25) and make it negative because it's to the left of the origin. Last, the box will need to sit on the ground, and it's half a meter thick, so Z will be half of the length, or 0.25.
[bookmark: OLE_LINK5]Confused yet? Didn't know all that figuring went into making those boxes around the base of the building, did ya? (If you're still confused, re-read the Quick Guides to Geometry on the Getting Started page.) If you need to, for now, just make the settings like I show you. It's sometimes difficult for people to grasp geometry in the 3d world (I know it took a while for me to catch on at first), but with time it will become second nature.
Rename the box "Foundation - Decoration".
[image: finite3.jpg]
To save a heck of a lot of math, simply clone your box, change X to equal 1.25 (that'll put the "top" of the box on the exact opposite side), and change the height to -7.25 to reverse its direction. 

[image: finite4.jpg]

To continue the box around the building, clone "Foundation - Decoration" (not the copy of it you made - trust me). To put it on the side wall, we'll first need to rotate it. Notice when you first use choose the "Select and Rotate" button that gmax shows the Z rotation as -90? To rotate it 90 degrees more, we'd type 180 in the Z rotation box (I just typed "180" and the BAT changed it to negative - but either way you type it in you'll get the same results). As we need to put this box on the wall, centered within it (just like the decoration on the front), hit the "Select and Move" button, then make X the same as the X for the left wall (-8.0). Finally, because the wall is 32 meters long, you'd change the height to 32 meters so it goes from the front edge of the side wall to the back edge. This next one is very simple. Clone "Foundation - Decoration02"and (using "Select and Move") make X = 8.0to place it on the right wall.

[image: finite5.jpg]

To put the foundation on the back wall, clone "Foundation - Decoration" first and make it's Y = 32 (the same as Y for the back wall). Now, do the same with "Foundation - Decoration01". You now have the picture above. See that unsightly gap between the edge of the doorway and the start of the foundation? We are going to fix that, but it'll take a little explaining.

[image: finite6.jpg]

To fix it, first we'll need to make the boxes the correct length. You could go through all the math like we did for the front wall, but I'm so lazy that I don't want to go through all of that again. Instead, do this:
 (
The back door is smaller than the front door
)
We already know the back door is 1 meter narrower than the front door. To put the "tops" of the boxes in the correct place, we'll just need to subtract half that distance from X.
1.25 - 0.5 = 0.75
(remember that for one side X is negative)

Since we're moving the "tops" of the boxes in by half a meter inward, we need to add half a meter to the height.
7.25 + 0.5 = 7.75
(remember that for one side the height is negative)
[image: ]

Viola! We now have our foundation in place. Take a serious breather now - I don't know about y'all, but my wee little brain is a bit fried...

[bookmark: OLE_LINK6]Ok, break over. Didn't think I was going to let you sit there and do nothing forever, did you? At any rate, next we will be creating the overhangs on the roof. Don't worry, this'll be far easier than the foundation.

[image: finite7.jpg]

The first thing you're going to want to do is clone the foundation piece on the left wall. Be sure to rename the copy "Roof - Overhang". To place it on top of the wall, use a Z move of 5.25 (we're simply moving it up 5 meters to place it on top of the wall). Clone the new piece, and change X to equal 8.0 (this places it on the exact opposite wall).
[image: finite8.jpg]

Next, we'll need to make the piece for the front wall. Do this by cloning "Roof - Overhang01" and Z rotate it by -90 (rotating it by 90 will make it turn the other way). Notice how it doesn't line up on the right-hand side and how it's way too long for the left? That's a pretty easy fix.

First, change the height to 17. Why 17 you ask? The front wall is 16 meters long, and we need this piece to overhang by 0.5 meters on each side. 16 + 0.5 + 0.5 = 17. Next, you'll need to change X to 8.5 to place the end of the box even with the overhang on the right wall. It's 8.5 because half of the wall's length plus the 0.5 meter overhang is 8.5 (refer to earlier explanations if you're having difficulty understanding this point).

Now that you have perfect placement for the front overhang, clone it and change Y to equal 32. This places it on the back wall.

[image: finite9.jpg]

See, that wasn't so hard, was it?

You know, now that I look, our front and back doors look a little plain. Let's do something about that, shall we?

Most commercial buildings have an overhang of some sort over all of their doors. BAT Tutorial, Inc will be no different. I think a nice, rounded overhang for the front door, and a simple, flat overhang for the back door.
[image: finite10.jpg]

First thing's first, select "Wall - Front" and hide unselected. That way, all that other junk won't be getting in our way. Turn 3d Snap on and make doubly sure that you have the Grid and Snap Settings set to Vertex. 
[image: Imagem]Next, on the Create Tab and Splines Button, pick "Arc"[image: 未标题-8.jpg]. Just to forwarn you, this will get a little bit tedious, but I think you should have enough basic knowledge to get into something a little more advanced. I guess Emeril would say we're going to "kick it up a notch - BAM!"

In the front view, snap the arc on the top two vertices of the door frame. Notice that arc is different than creating a line, instead of only clicking the vertices you want to add, you need to click and drag. Once you have the mouse button released and the line created, move the pointer up and down to see how the "curve" gets into the arc. We're not looking to make anything huge, so move the pointer until the arc is just about like I have it and left-click to finish it.

NOTE: If something doesn't turn out exactly the way you want it to, or you accidentally do something you didn't intend to do, Edit >Undo (or keyboard shortcut Ctrl + Z) can save you. There is a limit to how many times you can "undo", but as long as you catch a mistake early enough, it can save you from redoing something all over again. Undo is my absolute best friend!

[image: finite11.jpg]

Next, change the radius of the arc to 2.5 to give it the desired width. You do not have to worry about the "From" and "To" boxes (this is similar to a slice operation, but I'll explain that later). This will make the arc move upwards. The reason for this is because the arc is a almost like a sliced section of a circle, and when you increase the radius of the circle, it moves the edges outward from the center (I'll get into all of that sometime later). The arc is too high on the wall to make a proper overhang, so we'll move it down by doing a Z move to 1.5 (you're actually moving the center of the circle down, but that's not really important right now).

[image: finite12.jpg]

Now, make a cloned copy (do not make an instance) of the first arc and Z move it to 1.8.

[image: finite13.jpg]

Make sure 3d Snap is still on and snap a line onto the ends of both arcs. Remember that when creating lines you only click where you want gmax to put the vertices. Also, don't forget it will let you click forever, so hit "Esc" after you've placed the second vertex. Move over to the other side and repeat.

[image: finite14.jpg]

Just like we did when we attached window openings and doorways to the wall, place an Edit Spline modifier on one of the arcs and attach the lines and other arc. They will now become one object. Now, you'd put an extrude modifier on it and change the extrude amount to 3.0. What the...??!!??

[image: finite15.jpg]

Just what in the heck happened there?

[bookmark: OLE_LINK7]Welp, good thing for y'all that I know how to fix it! First thing's first, right-click on the Extrude Modifier in the Modifier List and pick Delete.

[image: finite16.jpg]

Now, I can tell you what happened. Whenever you create an object like this and simply attach the splines together, gmax will only extrude the faces. This is because gmax doesn't see it as a solid object, but instead a series of faces more or less grouped together. To fix this, we'll have to Weld the vertices together to create a solid object to extrude. Don't worry, it's not as difficult as it sounds. First of all, change your selection method to "Vertex" in the Edit Spline rollout. 

[image: finite17.jpg]

Next, make sure that you have "Select" turned on and not "Select and Move" or "Select and Rotate", and drag a box over one of the corners on your shape. You can't see it here, but you are actually selecting two vertices (the vertices will show with those funny green boxes attached to them). Now, down in the Geometry rollout (where the Attach button is) hit the "Weld" button. When that's done, the little box down by the X, Y, and Z boxes will say something like above. You'd then repeat this operation for the other four corners (the vertices where you snapped the line). Notice that each time you do that, the "out of x welded" number will change. That is because you created one vertex out of two, thus reducing the total number.

Now you can put your Extrude Modifier on the object and change the amount to 3.0.

Rename the object "Overhang - Front". 

[image: finite18.jpg]

Whew, that was a lot of work, but now we've got a nice-looking rounded overhang to go over the front doorway. It looks kinda strange just hanging there in the air holding itself up, doesn't it? We'll take care of that now, and believe me, it's much simpler than making the overhang!

[image: finite19.jpg]

Create a cylinder in the top view (create tab >geometry button >cylinder) of any size. Don't forget that since this is 3d geometry, you not only have to create the circle, but you also have to give it depth, so pay attention to your other views. Move the cylinder to the approximate place that I show it (doesn't really have to be exact) and change the properties as shown. I really only changed the radius and height, but look in the front view to make sure the cylinder actually sticks into the overhang a little. 

Rename the cylinder "Overhang - Support Front Lg".

[image: finite20.jpg]

I don't think it would look quite right having just a plain 'ol pole sticking into the ground, so to give it the "illusion" of having more detail than it actually will, clone your cylinder (make a copy and not an instance) and change the parameters like shown. This will put a base on the pole.

Rename the small cylinder "Overhang - Support Front Sm".

At this point, group the two cylinders and name the group "Overhang - Support Front", create a clone, and X move (change the value in the X box) to be the positive of the number currently there (for mine it was -1.445, but yours may be slightly different). That will put a new column exactly on the opposite side. Now would be a good time to save again.

[image: ]
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Finite Details Continued
The back door also needs some sort of overhang, but it's going to be a little simpler than the front. First and foremost, switch the top view to back (right-click where it says "Front" and go to Views >Back) and it wouldn't be a bad idea to use the "Arc Rotate" to move the perspective view around to the rear. This isn't absolutely necessary, but it does help when you're doing a lot of modeling around the back of a building. You may now want to hit the "Zoom Extents All Selected" button[image: 未标题-2.jpg]to re-center and zoom all views on your rear wall. Now, you'll want to turn 3d Snap off(it can get very complicated if you have the object snapping to all sorts of wierd verticies). 

[image: finite20.jpg]

Create a box of any size in the top view, and change it's parameters as shown. Next, you'll want to make sure that X is 0 (centers it on the door), Y is 32.7 (puts part of the rectangle in the wall a bit) and Z is 3.6(puts the overhang above the door). Rename the box "Overhang - Rear".[image: ]

[image: finite23.jpg]

Looks a little plain, don't it? We'll fix that. First, turn 3d snap back on, and snap a line on the top of the box (notice you will only snap the line onto the two sides and the front - it'd look a little strange with the line showing on the back too). Don't forget to add an edit mesh modifier or this line won't show in the final render. Rename the line "Overhang - Rear Decoration".
[image: ]
Now, clone your line and move it down until it lines up with the bottom face of the box (pretty easy when it's only got four sides).
[image: 0314.jpg]
[image: finite24.jpg]

Still in the top view,create a cylinder of any size and change its parameters as shown (you could reduce the number of sides if you wanted, but its not really important for this). Line it up with the overhang (I didn't change X and Y, I simply moved the cylinder into a place that looked about right), but do a Z move to 3.8 (makes it stick out of the top of the overhang).

Rename the cylinder "Overhang - Rear Support".

[image: finite25.jpg]

It's supposed to be a support, but it really won't support much just sticking straight up in the air, will it? We'll need to rotate the cylinder so that it sticks into the wall. Make sure you pick "Select and Rotate", and do an X rotation of 50 (rotates it clockwise 50 degrees). Perfect! Now, just clone the cylinder, be sure to switch back to "Select and Move", and change the value for X from negative to positive (to place it exactly on the opposite side).
[image: ]
Whew! I'll bet you didn't think that all of that went into some of the detailing, did ya? Don't worry, if you need to take a break, by all means do so!

Minute Details
Roof Junk and Whatever Else Comes to Mind

[image: minute1.jpg]

Let's take a minute to review.

You should now know how to create a wall, with the appropriate openings, using extruded splines. You should also know how to create windows, doors, their appropriate frames, and add some detailing to a building. It's starting to look more like an actual building, but there are some very important things missing. Whenever I get to this point, I try to think of things that a building like this might have. Roof junk like HVAC units (stands for "Heating, Ventilation, and Air Conditioning" or "High Volume Air Conditioning"), ducting, and piping is the first thing that comes to mind. Since the perspective in SC4 shows more of the roof than anything else, roof junk is critical to a realistic building. This doesn't mean that should be your only focus, however. Other things like corner decorations, window sills, light fixtures, electric meters, and pavement (under the overhangs) can also lend themselves greatly to creating the perfect building.

Remember at all times that the motto of Vu Industries Construction Division is "Details, details, details." The more you add to a building, the better it will look in game. There does become a point where the detail is too small, but you'll learn where those limits are the more experience you gain with the BAT/gmax.

Since the roof junk is the most critical, we'll start with that. 
[image: minute2.jpg]

I'm going to start by making a simple HVAC unit. Because it will be easier to model this whole thing "on the ground", hide everything before you start. In the top view, create a box of any size and adjust the parameters as shown. Next, move it to be exactly in the center by adjusting X, Y, and Z just like so. At this point, "Zoom Extents All Selected" can come in very handy.

[bookmark: OLE_LINK8][bookmark: OLE_LINK9][bookmark: OLE_LINK10][bookmark: OLE_LINK17]Rename this box "Roof Junk - HVAC Base".

[image: minute3.jpg]

Now that we've got a solid base, we're going to need somewhere to put all the "mechanicals" this HVAC unit will need. Still in the top view, create another box and adjust its parameters as shown. Since we want this box to sit on top of the other one, we'd adjust X and Y to 0 and Z to 0.25 (the base will stick into the box a little). The reason why X, Y, and Z are so easy here is because we created the box in the top view, so gmax looks at the bottom of the box (the initial rectangle) as the "top" and uses it to establish where the coordinates put something.
[bookmark: OLE_LINK19][bookmark: OLE_LINK18]Rename the box "Roof Junk - HVAC Mechanical".[image: 3541.jpg]

I believe it's absolutely critical that you understand why gmax moves objects around the way it does. It can save a lot of guesswork for you later if you understand these concepts (making it easier to manipulate objects in 3d space and save on modeling time). If you don't get it right now, don't fret about it too much. Once you've modeled for awhile and re-examine the movement system, you will really understand why everything does what it does.

Ok, enough of my preaching. *Puts soapbox away.* On with the tutorial!

[image: 3949.jpg][image: minute4.jpg]
So now we have a nice HVAC box, but that wouldn't look very good in the game, now would it? Next, we'll need to add vents to the front. In the top view, create a cylinder and adjust it's parameters like so. Notice that I checked "Slice On" and made it "Slice From"0 and "Slice To"180? What this does is tell gmax to cut the cylinder in half. The "Slice From" and "Slice To" fields are degrees on a circle. See the diagram below. You'd also want to move it to the X, Y, and Z shown to put it exactly on the front of the mechanical box.

NOTE:If you uncheck the "Smooth" box, then gmax will show the individual planes that make up the faces of the cylinder. With that box checked, gmax attempts to smooth out the surface. It is not able to do that when its given too few faces, however. If you have a complete cylinder (no slicing done), 18 sides is the minimum to show a completely smooth side - at least from my experience. Anything less than 18 and the sides start to look a little flattened. I wouldn't add too much more than 18, however, as the more you add, the more to texture later (and it will increase the export time).

[bookmark: OLE_LINK20]Rename the cylinder "Roof Junk - HVAC Vents".

[image: minute5.jpg]

This is basically how gmax assigns the degree increments to the circle (I didn't show all 360 degrees - I'm sure you can fill in the blanks). Keep this in mind, it can become very handy for you later. So, the reason that the slice above worked as it did is because we told gmax to remove everything between 0 and 180 on the circle. Take note that you can enter degrees down to the thousanths (or x.xxx), so you can get pretty darn exact with it. Also, if you wanted to slice from 0 to 270, you could either type it in as "From: 0" and "To: 270" or "From: 0" and "To: -90". I find it a little difficult to keep track of what I'm doing when I put negative degrees in the spots, so I usually stick to the above. This is independent of the view you are in, it's based on the top of the cylinder. You also might notice that when the cylinder is sliced, what's remaining still has 9 sides (see the last picture). Keep that in mind as you're modeling - if you got just the right look for something and slicing it made the object come out all wrong, you'd need to make adjustments to the sides.

I know what you're saying now, "Enough of the geometry, let's get on with it!" Alright, alright, don't push... LOL.

[image: minute6.jpg][image: 0415.jpg]

We've got a good start to an HVAC, but it has no ducting! Well, to take care of this, we'll put some on the back. First, create a cylinder in the left view, and change the parameters like so. Since we're only going to want an "elbow" joint, be sure to slice as shown. This will give you that nice 90 degree angle cut that you want (you could have also sliced with different degrees and simply rotated it - but I believe in keeping everything as simple as possible). Now, make X, Y, and Z like so to put it in a good place.

[bookmark: OLE_LINK21][bookmark: OLE_LINK22]Rename the cylinder "Roof Junk - HVAC Bend Pipe".

This next part's gonna get a little tricky, just thought I'd warn you.

[image: minute7.jpg]

What I want is a nice elbow joint without being one complete piece (ie - I don't want the whole thing just to look like it is a section of a cylinder). To do this, I'm going to do something that seems impossibly complicated at first, but once you get the gist of it won't seem so difficult (make sure your cylinder has "Cap Segments" of 5). First, apply an edit mesh modifier to your cylinder and make your seletion method "Vertex" in the edit mesh rollout. Next, change your selection method to circle (next to the "Select Object" button on the toolbar, there's the button that looks like a box with dots around it - hold that button down so you can pick the circle) and drag to select the inside two sets of verticies, which will turn red. Now, hit the "Delete" button on your keyboard and gmax will get rid of the verticies and any "faces" that were attached to them. This is how I wanted that pipe to look.

NOTE: The bottom and back of this shape is now empty, meaning that if you look behind or below it, you'll just see empty space like it's not even there.[image: ]
 That could be fixed, but since you're not going to see it from that angle in the game, there really isn't any point to bother with it (though I will get into fixing things like that on a later page).
[image: minute8.jpg]

Since we're going to need two ducts (one for the inward flow, and one for the outward), you'd simply clone your object and X move it like so. The reason it's not simply 0.25 (the first one's X was -0.25) is that gmax is going to move this object based on it's top and not the middle of the object, just like the roof overhangs. So, to move it to the exact opposite side, we'd change X to the opposite of the first X and add the width of the duct, giving us 0.75.

[image: minute9.jpg][image: 1722.jpg]

Well, now, the HVAC doesn't do us any good if it blows all of the air onto the roof, now does it? To attach your ducting to the building, create a box in the back view (not the top view this time) and change its parameters like shown. To put it underneath the bend pipe, make it's X, Y, and Z thus. Notice how it sticks down below the bottom of the base unit (and will therefore stick into the roof)? Do not worry about that at all, it's perfectly OK for it to do that. Even in a building with all transparent windows, it will not be visible from the view in the game unless its extremely close to the edge of the roof.
Rename the box "Roof Junk - HVAC Ducting".
To place another duct, clone your existing one and change the X to -0.5.

[image: minute10.jpg]

Congratulations! You now have a completed HVAC unit ready for texturing. Before you get too deep in celebration, it would be a good idea to group all of your HVAC pieces (Group menu >Group) and name it "HVAC". Next, unhide all and move the group like shown. The reason I had to group them first is so gmax moved them as a single unit and not individual pieces. If you didn't group them first, then tried a numeric move (typing values in the boxes), then it would have made the X, Y, and Z of each individual object what you typed in - meaning they'd have all been piled on top of one another (and the only thing you'd be able to see in perspective is the larger mechanical box). Definately not what you'd want to happen! There will be more than one HVAC on this building when we're done, but to save some time on the texturing later I'll leave just one there for now. After it's textured, you can clone it or array it.

Now would be a good time to save your file.
Part 3
Minute Details continued
[image: minute11.jpg]

Next, we'll create some simple exhaust pipes (these are usually what's on the other end of the exhaust fan in a bathroom). Just like with the HVAC, it'll be much simpler to hide everything. In the top view, create a tube of any size (tube can be found in the same place as box - Create Tab >Geometry) and adjust its settings like shown. Just a little note here, "Radius 1" is the outside radius and "Radius 2" is the radius of the inside circle. When you create a tube, you first have to create the outside circle (click and drag), then you'll create the inside circle (move the pointer around until you've got it something like you want it) and click again to set it. Just like all other geometry, you also have to give this one depth, so pay attention to your other viewports.

Rename the tube "Roof Junk - Exhaust Pipe".

[image: minute12.jpg]

We've got the pipe done, but it wouldn't look right just sticking out of the roof. To make it appear to have "flashing" (the piece of material that covers the area where the pipe pokes through the roof - water-proofs the hole so that rain doesn't get in), clone your tube and make its settings like so. There is no need to adjust X, Y, and Z because everything is sitting on the ground already (gmax is going to see the bottom of the tubes as the "top" because that's the first part that was created). I changed the color of the base so it's easier to distinguish between the pipes in the perspective view.

[bookmark: OLE_LINK23][bookmark: OLE_LINK24]Rename the new tube "Roof Junk - Exhaust Pipe Base". (if you end up with a lot of these, it's very helpful to be able to distinguish between the bases and the pipes themselves when it comes to texturing)

[bookmark: OLE_LINK25][bookmark: OLE_LINK26]Now, group both of them and name the group "Exhaust Pipe". Just like with the HVAC, we're only going to make one of these for now, so move them up onto the roof like shown:

 (
Unhide All
)[image: minute13.jpg]

We're not quite finished with the roof yet. To spruce up this big expanse of roof, we're going to add duct work. While it is unusual for smallish building like this to have much on the roof, it's mostly what we'll see in the SC4 environment, so it's OK to fudge reality to make something a bit more interesting.

[image: minute14.jpg]

In the top view, create a box, change its parameters like shown, and move it up to 5.3 meters. For this particular object, it really won't matter where you put it on X and Y so long as its 5.3 meters in the air (so it will sit on the rooftop). Rename this box "Roof Junk - Ducting Endpiece".

[image: minute15.jpg]

Next, clone your first box, adjust its parameters like shown, and move it until its approximately like that. If you restrict movement to the Y arrow, it will make that much easier. Be sure to rename this box "Roof Junk - Ducting". (I did change the color of this object so that it's easier to see in perspective.) Continue cloning your pieces (rotating if necessary) until you end up with something like below. Placement for all roof junk is not critical at this point, because you'll probably just end up moving everything around later. I created the ducting like this because it's simple (and ducting is pretty simple-looking in real life) and because it'll make you're life much easier if you plan to re-use this ducting on another model.

[bookmark: OLE_LINK29][bookmark: OLE_LINK30][bookmark: OLE_LINK31][bookmark: OLE_LINK32][bookmark: OLE_LINK33][bookmark: OLE_LINK34] (
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 with 
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s due to we need to move them again at the last.
)Now would be another good time to save.

[image: minute16.jpg]

So far we've been focusing on the roof, but there are some other minute details that need addressing. While our model looks good, it couldn't hurt to do a little sprucing up.

[image: minute17.jpg]

Remember that unsightly gap on the back of the side walls? I said before I was going to show you how to fix that, and I'm going to do that now. Instead of playing around with the wall until the windows line up correctly (cause that could take a lot of messing around, including the glass and window frames), I'm just going to fill it in with something that'll look good. For this wall, we're going to put a small electrical box. It won't have to be anything fancy, because it'll probably only be a few pixels in the game anyway.

[image: minute18.jpg]

For small details like this, don't worry about getting just the right placement. In the left view, create a box and change its parameters like this. To put it on the left wall, do an X move to -8. Rename this box "Misc - Electrical Box".

[image: minute19.jpg][image: 20200118220606.jpg]

How many electrical boxes don't connect to wiring in some way? Since the SC4 City Council has decided that all wiring within the city limits is underground, simply clone your box,rename it "Misc - Electrical Wiring Tube", change its parameters, and move it down until its about like I have it. It is perfectly OK for the box to stick below the building, as that will not show in game anyway. If you were so inclined, you could clone both these objects and move them to the opposite wall at this point, but I wouldn't think that'd be necessary as most smallish commercial buildings don't have several electrical connections. But what do we put on the right wall? I'm not going to put anything, because later we'll move a couple of roof pipes back there. This gives the illusion that you have a Mechanical Room on the left side (most modern buildings have one - its where all the telephone lines, power lines, and gas lines come in and connect to various equipment - also, many of these rooms will also have air returns and numerous other things that make the building live and breathe). The pipes on the right side will give the illusion that behind the blank wall-space lies the bathrooms. Your Sims have to relieve themselves some way, don't they? 

[image: minute20.jpg][image: 04571.jpg]

We're now going to create a light fixture to stick by the back door (the front door will have a light under the overhang - but I'll get into that later). In the top view, create a sphere (it's in the same place as the box, cylinder, and tube - click and drag) and adjust it's parameters like shown. It's perfectly OK to guesstimate the X, Y, and Z here as exact placement isn't critical (unless you're a control freak - LOL), but I set mine as shown. Rename the sphere "Lighting - Back Door". You could go into more detail on the light, but it really isn't absolutely necessary. Well, now, we've got a bit of detailing, but our windows look a little plain. Let's create some sills for them, shall we? 

[image: minute21.jpg][image: 1051.jpg]

In the top view, create a box and set its parameters as shown. Take special care to make sure that "Length Segs", "Width Segs", and "Height Segs" are like this (will become important in a few moments). You can try eyeballing where to place it, but it'd probably be easier to just trust me and put X, Y, and Z thus. You do trust me, don't you?

Rename the box "Windows - Sills".

[image: minute22.jpg]

This is where the segments becomes important. First and foremost, apply an edit mesh modifier to the box and change your selection method to "box"[image: 20200118221947.jpg] (see earlier on this page for how we changed it to "circle"). In the left view, drag-select (drag the box) around the middle set of vertices - notice they turn red.
[image: 2326.jpg]
 It's very important to select the vertices this way, otherwise when you click on vertices you'll select only one at a time instead of the middle set all the way across. Now, Z move them up to 1.4. Next, drag-select the vertices on the lower right-hand corner and make sure that you see only one red dot.
[image: 2513.jpg]
You'd Y move them to -0.2 (this puts them directly on top of the bottom middle set of vertices, so they'll look like they disappear, but they're still there). Be sure at this point to click on Edit Mesh in the rollout so you exit the vertex editing mode. You now have a nice, basic window sill, but it seems to be lacking something. Next, we'll spruce it up a bit.
[image: minute23.jpg][image: 20200118223022.jpg]

Just like we did for the overhang over the back door, we're simply going to outline the top of this sill. In the top view, snap a line on the front and sides of the top and make its parameters like so. Don't forget to add an edit mesh modifier or it will not show in the render.

Rename the line "Windows - Sills Decoration".

[image: minute24.jpg]

We're not quite done yet. It'd be a good idea to highlight the bend on the front (you will probably have difficulty seeing it in SC4 - but this will help). In the front view, snap a line across the "bend" (the two middle vertices directly below the top) and change its parameters as shown. Make sure you add an edit mesh modifier to this line or it won't show in the render.

Rename the line "Windows - Sills Edge".
[image: 3512.jpg]

Select both the new lines and the sill and group them as "Windows - Sills".[image: 20200118223614.jpg]
Just like we did for the window openings, clone and array your new sills around the building. Notice that with them grouped you can see the X, Y, and Z for the group. A little tip, if you want the sill to protrude exactly the same way on all walls, the X for the left wall would be -8.225, the right would be 8.225, and the Y for the back wall would be 32.225. This is because your lines added some size to the entire sill. 

[image: minute25.jpg]

We're still not done modelling yet. I know what you're going to say, "Jeez, I just want to upload something to the BEX. Why do I have to go through all of this?" Simple. If you want a building that's going to actually look like a building, then you can't scrimp on the details. The sad thing is this building will not even get anywhere near as detailed as something as seemingly simple as Vu Quest or Vu Med!

Now would be a good time to save again.

Next, we'll put some concrete in front of the doors. Very simple, so shouldn't take me much to explain.
[image: minute26.jpg]

In the top view, create two boxes and adjust their parameters like this (you don't have to create both of them at the same time). If gmax wants to give them the same length, width, and height segments as the window sill that was created, that's perfectly fine, but they're not needed so I changed that. I did hide the front overhang so you could actually see the concrete on the front.

Rename the boxes "Foundation - Front Entrance Concrete" and "Foundation - Back Entrance Concrete" respectively.
See, that wasn't so hard was it?

[image: minute27.jpg]
Promise, this is the last bit of detailing. To round out the building, we're going to put decorations on the corners. Since I'm trying to keep this simple, create a box in the top view, and make its parameters and X, Y, and Z as shown.Rename this box "Misc - Corner Decorations". All you'd do now is clone the box and move it to the other three corners (X for the right is 8.0, and Y for the back wall is 32).
[image: 20200118224631.jpg][image: 20200118224731.jpg]

Save your file yet again. 
[image: minute28.jpg]
Congratulations! We now have a completed building model ready for texturing and lighting. What I've just shown you how to do took me weeks to learn. Don't worry about the "tessellations" and weird things you see happening in the perspective view. The more detail you add and the larger your model gets, the more likely perspective will get "choppy". It's absolutely nothing to worry about, it's just that perspective view is sort of like a low-quality preview. If I were to render this building right now, you'd see it looks pretty good so far.

Texturing - The Essentials
We've now got a completed model, but to avoid it looking like some nightmarish cartoon creation, we'll need to texture it. If you have your own textures you'd like to use, you are perfectly free to do so. Below, I included all of the textures that I've used for this model. Take a moment to download them and put them in:
C:\gmax\maps
This is assuming that you let gmax install to the default path. If not, you'll need to change the above path to wherever you installed gmax.
Texturing can be very simple, or extremely complex depending on your level of skill and what it is you want to come out with. I'm not going to tell you everything that texturing can do, and in some places I've simplified the options available to better explain it to a beginner.

Please Download:
· TexturesA.zip
· TexturesB.zip

Now that you have all of the textures we're going to be using, let me give you a quick overview of texturing and the Material Editor.

[image: texture1.jpg]

First and foremost, you'll need to apply a UVW Map to the object you want to texture. This is not absolutely necessary for solid geometry (such as a box), but it can save a lot of effort later on.

[image: texture2.jpg]

Above is the illustration of the texturing rollout. Under UVW Mapping, you'll find the "Gizmo", but don't feed it after midnight. *crickets chirp* Yeah, I know, bad joke. At any rate, you can manipulate the UVW gizmo to do all sorts of things, and can be very useful if you're trying to get a texture to line up just so. It's way too much to explain, just play with it and you'll see what it can do. Down in the Parameters rollout, you'll find all sorts of new goodies. Under "Mapping", you can choose the characteristics of the map. Breakdown:
· Planar
Creates a flat texture - good for flat objects or plain textures, bad for anything else.
· Cylindrical
Awesome for getting perfect alignment on cylinders.
· Spherical
Same as cylindrical, but for spheres.
· Shrink Wrap
Does some strange things - haven't played with it much but I'm sure it's good for something.
· Box
Probably the one you'll use the most - great for just about anything, but perfect for boxes.
· Face
Can be very useful - places one copy of the texture on each face of the object.
· XYZ to UVW
I'm sure it's good for something, but I've never used it.
Under those choices, you have several important boxes. I really don't mess with length, width, and height, but if you're looking to manually change the size of the UVW Map you can do that here. The next three are probably the most important boxes in this rollout:
· U Tile - tells gmax how many "copies" of the texture to place left/right.
· V Tile - tells gmax how many "copies" to place up/down.
· W Tile - haven't got a clue what it does - I've made changes but it doesn't seem to affect anything.
If you make changes here, you'll notice that it's not quite the same as tiling in Windows (like on your desktop, for example). If U and V tiling are set to 1, then the texture will be stretched across the entire UVW Map. If you set U tiling to, say, 2.5, then gmax will copy the texture across the map two and a half times, but it will only stretch it up one. I'd suggest playing with them so you can see what they do, it's kinda difficult to explain.
The bottom of the rollout can give you some important options. I've never played with the Channels, so can't really tell you what they do. Under Alignment, the X, Y, and Z radio buttons will rotate the UVW Map to align with the different axes instead of aligning with the object. The only two buttons I've used here are Reset and Fit. If you've played around with the UVW Map and screwed it all up, you can hit Reset to undo some complex rotations you've done with the Gizmo. If you've messed around with the different Mapping options and now the UVW Map no longer fits your object, you can hit Fit and it will automatically re-size the UVW Map to fit the object.


[image: texture3.jpg]

Before we can get into actually texturing this bad boy, we need to become a little more familiar with the Material Editor. The first time you open it (by clicking that round button highlighted above), you'll get the window titled Material Editor, click "New". You'll then get the New Material window, select "Standard" and hit "OK". Once the gmax Material Navigator window opens, highlight "Bitmap" and hit "OK" (or you can double-click on "Bitmap"). In the Select Bitmap Image File window, navigate until you find the texture you're looking for, pick it, and hit "Open".
NOTE: You can use the following formats for textures: bitmaps (.bmp extension), JPEG (.jpg or .jpeg extension usually), PNG files (.png extension), Adobe PSD Reader (.psd extension), Targa Image File (most commonly with the .tga extension), and TIF Image File (.tif extension). Bitmaps and Targas are the most used texture types, and tend to not cause issues. I'd recommend, if you have to choice, to use bitmaps exclusively, but Targa files will do (and most people don't have software that can convert Targas to Bitmaps).
Also, while going through the textures, you may get a window that tells you there was an error reading a certain file. This only seems to happen to me on .tga files. I just click the "cancel" button as it's not anything to worry about. The funny thing is that if you apply that .tga file as a texture in gmax, the program suddenly doesn't have any other problems reading it. Go figure.
Once you've gotten through all that rig-a-ma-roll, you'll end up with the window below:


[image: texture4.jpg]

There's a whole lotta stuff in here, but I'll only explain the basics you'll need to know. First, the big buttons:
· "New"- lets you start a new material (texture).
· "Pick" - gives you an eyedropper-like pointer to choose the material (texture) already on an object.
· "Apply"- puts the material on all selected objects.
(you can also drag and drop the "ball" onto objects to do this - the objects do not have to be selected).
Next, the numbered items:
1 [image: 11.jpg]-  Allows your texture to show in the perspective view - if the object shows as just plain gray, make sure this button is clicked.
2 [image: 22.jpg]-Lets you go back up to change diffuse, opacity, and the like (explained below).
3[image: 33.jpg] -Lets that multi-colored background show behind the texture - very useful if you're making a window texture.
4 & 5 [image: 45.jpg]- U and V tiling. Note that while you can change the UV tiling from here, I would strongly suggest that you don't - it's much more easily accomplished from the UVW Map on the object itself. Also, you can choose here to mirror the U and V (U is left/right, so a mirror would flip it so it goes right/left, and V is up/down, so a mirror would make that down/up).
[image: texture5.jpg]

If you hit the "up arrow" button described in the last text section, then you get this window. Everything at the top functions the same, but I'll explain the numbered ones below:
1. [image: 1.jpg]You can select from "Blinn", "Metal", or "Phong" here. Supposedly, selecting metal is better for metals, but I honestly haven't noticed much difference. The default is blinn, so that's where we'll leave it.
2. [image: 2.jpg]Do NOT click this box, unless for some reason you really need to. With this box checked, the texture will apply to both sides of an object with no back (like a flat rectangle), but if its on transparent windows, strange things happen when you try to do lighting.
3. [image: 3.jpg]If you are trying to make a simple window texture that doesn't need a bitmap, or pretty much any simple color texture, then you'd hit the big gray box so that you can use the Color Selector (not shown). The Color Selector is pretty much self-explanitory, just pick the color you want and fine-tune it.
4. [image: 4.jpg]You won't need to worry with this box unless you create a new material (hitting the "New" button). When you do that, you'll have to hit the little box with the "M" (wouldn't be shown on a new material) to pick your bitmap - incedentally, if you hit the "M", it will take you back to the previous picture.
5. [image: 5.jpg]I wouldn't worry with this one at all. It will make your objects "glow", but it really doesn't look that great.
6. [image: 6.jpg]Opacity is how "see through" your object is. You can put any number from 0 to 100 in this box, 0 being completely clear (not visible at all) and 100 being totally solid (not letting you see anything behind it). If you hit the little box, you can pick an "Opacity Map", which will give you the same approximate results as putting a "Diffuse Map" (number 4's little box) and turning the opacity down (but it does do some complex things we don't really need to get into).
7. [image: 7.jpg]Specular Level is how much light your object will reflect. Don't get too carried away with this unless you want people to be blinded by your object! (The little ball at the top that shows you a preview of your texture will change accordingly to give you an idea of what it will look like.)
8. [image: 8.jpg]Glossiness is basically how "shiny" your object is. When used in conjunction with specular level, you can get pretty impressive shininess to your objects. Again, don't get too carried away. (The little ball at the top will change with this one too.)
I've said it before and I'll say it again, texturing can be very complex. I have simplified the above operations to an extent to be able to explain them to you as quickly as possible, but still be thorough. You will discover things can operate differently than I explained, and you'll probably find better ways to go about things yourself.
Before we get started, just a little tip. When you texture an object, even though you can see it in the perspective view, that's not necessarily exactly how it will show in the render. It's been my experience that the BAT render will lighten any textures you make up, and the SC4 environment will tend to lighten them up even more. Keep this in mind as you select textures, because you'll probably need to pick a texture a few shades darker than what you actually want it to look like.
[image: texture6.jpg]
[image: 20200120151203.jpg]
We'll begin at the beginning. Start by creating a new materialand follow through above to select "mjbB00002.tga".[image: mjbB0002.jpg]Make sure the little box[image: 11.jpg]that lets the texture show in the perspective view is clicked on. Select "Wall - Front", apply a UVW Map to it, and pick "Box" from the rollout. Hit "Apply" in the Material Editor to put the new texture on the wall.
Wait a minute, just who the heck made those bricks? 

[image: texture7.jpg]

Well, since the up and down looks fine (ie - the bricks look like the correct height), then we'll need to adjust the left to right tiling, which means we change U Tile. Change it like so. Why 2.5 you ask? Don't have an easy explanation, I just played with the number until it looked about right. Notice that, just like mirror in the Material Editor, you can check "Flip" and it will do exactly that - turn the material over.

[image: texture8.jpg]

To finish out the walls, select each one individually, apply the UVW Map, and apply the texture. Be sure to make the U Tile on the back wall to 2.5 and both side walls to 5. Why 5 you ask? This one's actually easy. Since we tiled 2.5 on the front wall, and the side walls are double the length, then we'd need to double the tiling to get the same effect.
You might notice that the bricks don't look right in the picture above. This is due to the perspective view in gmax, if you want to see what they actually look like, then you'd need to rotate the perspective view until you're looking directly at the object.
NOTE: When I'm texturing a building, I usually make the perspective view the maximum possible by hitting the Min/Max Toggle[image: 未标题-9.jpg] in the lower right-hand corner.


[image: texture9.jpg]

Next, we're going to texture the foundation and the roof overhangs. Create a new material (hit the "New" button), navigate until you can select "marble22.bmp".[image: marble22.jpg]
NOTE: When you create a new material after you've already created your first one, it will not follow through the same way. When you click "Standard" and then hit "OK", gmax will take you back to the material editor with a blank, gray material. You'll need to hit the little box next to "Diffuse" (#4 in the above example - the box with the M on it - it only has the "M" when you have a created material) to pick your texture.
Pick one of the foundations on the front, apply a UVW Map, pick "Box" and hit apply in the Material Editor. For this texture, we'll need to change V Tile like follows (select each object in turn and apply UVW Maps and the texture like we did for the first object):
· Foundation - Decoration: 10
· Foundation - Decoration01: 10
· Foundation - Decoration02: 40
· Foundation - Decoration03: 40
· Foundation - Decoration04: 10
· Foundation - Decoration05: 10
We'd now do the same thing for the "Roof - Overhang". Again, we'll need to change V Tile as follows:
· Roof - Overhang: 50
· Roof - Overhang01: 50
· Roof - Overhang02: 25
· Roof - Overhang03: 25
You should now have something that looks like the above picture. Take note that I assumed here that you had followed the instructions for cloning and arraying your decorations exactly the way I wrote them. If you did not, then you will need to adjust the above numbers to reflect where your overhangs and foundation pieces are.


[image: texture10.jpg]

Next, we'll do something a lot easier. Create a new material and pick "marble2.bmp".[image: marble2.jpg] Now, pick "Misc - Corner Decorations", apply the UVW Map, pick "Box", change the V Tile to 5, and apply the texture. Repeat for the other three corner pieces. You should now have something like the above.

[image: texture11.jpg]

This one's going to be even easier than the last one. Create a new material and pick "gravelroof2.bmp"[image: gravelroof2.jpg]. Pick "Roof - Surface", apply the UVW Map (leaving it as "Planar" is fine for this one), change U Tile to 16 and V Tile to 32 (we're making this map tile in 1 meter squares) and apply the texture. You should end up with something like this.

Pretty easy so far, huh? Well, good, cause now we're going to start getting into the hard stuff. Don't worry, I'll try not to let you get lost. 

[image: texture12.jpg]

▁▂▃▄▅▇(Plus Begin)
There are still some Texturing works left, Contrast the final results and lots, and combined with the textures (texture A B) which given by Mr. Phillipobbo, I will continue to add other parts. Please Follow me.
I’m going to deal with the windows first, Before that, I want to explain something first,After had done the Loting for the second times, I found that the texturing works can be simplified when we made some repeated objects, such as Windows, that is, for these repetitive tasks, you can Model it completely, thencolone or Array them,It will save some works if had a blueprint before your modeling. but I think Mr. P here just wanted us to become more familiar with Model skills first.

Select all of your "Windows - Sills"(Windows – Sills~ Windows – Sills52)and “Windows”(Windows ~ Windows27)groups, You can use the Hotkey “H” and then use shift or ctrl + click to select them. Then go to Menu>Group>Ungroup. After that let’s do this texturing works below:
[image: q1.jpg]
1, “Windows - Frame” :Create a new material 
and pick "vuquestuff21.bmp "[image: vuquestuff2.jpg]. Select All of the “Windows – Frame”objects(you can use shift or ctrl + click), apply the UVW Map,"Planar", and apply the texture.
[image: 20200119184758.jpg]
2, “Windows – Sills” :Create a new material 
and pick "marble22.bmp".[image: marble22.jpg]. Select just one "Windows - Sills"object(Don’t select them all as above, I will explain it later), apply the UVW Map,"Box", “U Tile = 2” and apply the texture.(You can use the ‘Pick’ button to chose the texture you have been used before), and thenyou need to do the samething to the other "Windows - Sills" individually.

Explain: when I first textured the "Windows - Sills", I group them and do the texturing works, But I found that some weird things happened when I looked at the sills’s texture carefully.
[image: w1.jpg][image: W2.jpg]
I guess that when I selected all of them and used the UVW, then the gmax treated all of them as a whole thing, you can tell from the first picture, but the “Windows – Frame” can use that way due to simple texture or color we used. So we can do the same simple and easier stuff next.

3, "Windows - Sills Decoration" and "Windows - Sills Edge" :
Create a new material 
and pick " vumedroofstuff.bmp "[image: vuquestuff2.jpg]. Select All of the "Windows - Sills Decoration" and "Windows - Sills Edge"objects(you can use shift or ctrl + click),apply the UVW Map,"Planar",and apply the texture. Then we get this:
[image: w3.jpg]

4, “Windows - Glass” :
Create a new material 
and pick " cloudsandstuffandmeanit.bmp "[image: cloudsandstuffandmeanit.jpg]. Click the “Go to Parent”[image: 20200119202848.jpg]button then set the parameters as this: [image: 20200119204054.jpg]
Then click this M button [image: 20200119203324.jpg] set the parameters as below, Select All of the "Windows - Glass”objects(here we use that way since I thought the air should be transfer to every windows), apply the UVW Map,"Planar",and apply the texture. Then we get this:
[image: 20200119205824.jpg]
You can tweak these settings as you like, however I thought you need to pay attention to the UV settings. I made the first lot without change these parameters, It looks like weird.[image: 20200119203511.jpg]
5, “Doors - Front” “Doors - back”  :
Create a new material 
and pick "mjbD0002.png"[image: mjbD0002.jpg]. Select “Doors – Front”objects,"Planar", and apply the texture.
Create a new material 
and pick "backdoor.bmp "[image: backdoor.jpg]. Select “Doors – Back”objects,"Planar", and apply the texture.
[image: 20200119214145.jpg][image: 20200119214236.jpg]
6, “Doors - Frame Front” “Doors – Back Frame”  :
Create a new material 
and pick "metal181.bmp "[image: metal181.jpg]. Select “Doors - Frame Front”objects, apply the UVW Map,"Planar", and apply the texture. Do the same with “Doors – Back Frame”

[image: 20200119215123.jpg][image: 20200119215144.jpg]
7, “Foundation - Front Entrance Concrete” “Foundation - Back Entrance Concrete”  :
Create a new material 
and pick "benton69ab.png"[image: beton69ab.jpg]. Select “Foundation - Front Entrance Concrete” objects, apply the UVW Map,"Box", and apply the texture. Do the same with “Foundation - Back Entrance Concrete”
[image: 20200119220529.jpg][image: 20200119220622.jpg]

8, “Overhang - Front” “Overhang - Rear”  :
Create a new material 
and pick "vuquestuff2.bmp "[image: vuquestuff2.jpg]. Select “Overhang - Front”objects, apply the UVW Map,"Box", and apply the texture. 
Create a new material 
and pick " mjbM0011.bmp "[image: mjbM0011.jpg]. Select “Overhang - Rear” objects, apply the UVW Map,"Box", “U = 5”and apply the texture. 


[image: 20200119222036.jpg][image: 20200119221505.jpg]

9, “Overhang - Support Front”“Overhang - Rear Support”:
Ungroup “Overhang - Support Front” and “Overhang - Support Front01”Create a new material 
and pick "titanium.bmp "[image: titanium.jpg]. Select “Overhang - Support Front Lg”objects, apply the UVW Map,"cylinder", and apply the texture. Do the same with “Overhang - Support Front Lg01” and “Overhang - Rear Support” and “Overhang - Rear Support01”

10, “Overhang - Rear Decoration”“Overhang - Support Front Sm”:
Create a new material 
and pick "drab_concrete.bmp"[image: drab_concrete.jpg]. Select “Overhang - Support Front Sm”objects, apply the UVW Map,"cylinder", and apply the texture. Do the same with “Overhang - Support Front Sm01”
Create a new material 
and pick "vumedroofstuff.bmp "[image: vumedroofstuff.jpg]. Select “Overhang - Rear Decoration”objects, apply the UVW Map,"cylinder", and apply the texture. Do the same with “Overhang - Rear Decoration01”
[image: 20200119225113.jpg][image: 20200119224807.jpg]

11, “Light - Back Door”:
Create a new material
and pick "MaxisGarbage.bmp"[image: MaxisGarbage.jpg]. Select “Light - Back Door”objects, apply the UVW Map,"Box", and apply the texture.(I‘m not very clear with the material here, So I choose a similar one, I guess you can use your own pictures or choose a color from Diffuse)

12, “Misc - Electrical Wiring Tube”“Misc - Electrical Box”:
Create a new material
and pick "MaxisGarbage.bmp"[image: MaxisGarbage.jpg]. Select “Misc - Electrical Wiring Tube” objects, apply the UVW Map,"Box", and apply the texture.
Create a new material
and pick "MaxisGarbage.bmp"[image: metal_buttons2.jpg]. Select “Misc - Electrical Box”objects, apply the UVW Map,"Box", and apply the texture.

[image: 20200119231305.jpg]

13, “Foundation - Floor”:
Create a new material
and pick "carpet.bmp"[image: carpet.jpg]. Select “Foundation - Floor” objects, apply the UVW Map,"Box", “U = 16”and“V = 32” (here I set the UV according to the Floor’s size,you can try to adjust them as you like, I just want to set one carpet in one tile) and apply the texture.
[image: 20200119234111.jpg]

14, “HVAC”:
Ungroup the “HVAC”, “Hide Unselected” Select “Roof Junk - HVAC Vents”objects, apply the UVW Map,"cylindrical", Click the “Fit” button, [image: 20200119235856.jpg]Create a new material
and pick "vent.bmp"[image: vent.jpg]. and apply the texture.
Create a new material
and pick "MaxisGenericRoof1.bmp"[image: MaxisGenericRoof1.jpg]. Select “Roof Junk - HVAC Mechanical”objects, apply the UVW Map,"Box",and apply the texture.
Create a new material
and pick "metal_buttons_rusty.bmp"[image: metal_buttons_rusty.jpg]. Select “Roof Junk - HVAC Base” objects, apply the UVW Map,"Box",and apply the texture.
Create a new material
[bookmark: OLE_LINK35][bookmark: OLE_LINK36]and pick "cookiesheet_crackle_ofsq.bmp "[image: cookiesheet_crackle_ofsq.jpg]. Select “Roof Junk - HVAC Bend Pipe” objects, apply the UVW Map,"Box",and apply the texture. Do the same to “Roof Junk - HVAC Bend Pipe01” and “Roof Box - HAVC Ducting” and “Roof Box - HAVC Ducting01”, I try to use “X” alignment method to one set, the other set I choose “Z”, but the “Y” here seems not very appropriate, You can try it.
[image: 20200120002630.jpg]
Group all the HVAC stuff with it’s original name “HVAC”, unhide all, Then clone the 
“HVAC” group, move the group HVAC01 “X = -2.0”

15, “Roof Junk”:
Create a new material
[bookmark: OLE_LINK39][bookmark: OLE_LINK40]and pick "cookiesheet_crackle_ofsq.bmp "[image: cookiesheet_crackle_ofsq.jpg]. Select “Roof Junk - Ducting Endpiece”objects, apply the UVW Map,"Box", and apply the texture. Do the same to “Roof Junk - Ducting Endpiece01” and “Roof Junk - Ducting Endpiece02”
Create a new material
[bookmark: OLE_LINK37][bookmark: OLE_LINK38]and pick " cookiesheet_crackle_ofsq-2.bmp "[image: cookiesheet_crackle_ofsq-2.jpg]. (I couldn’t figure out the pipe’s texture, so I made a texture by myself),Select “Roof Junk - Ducting”objects, apply the UVW Map,"Box",“U = 0.5”and“V = 1”and apply the texture. Do the same to “Roof Junk – Ducting01”.
Group all the Roof Junk above with a group name “Roof Junk”, Move it to X = 0, Y = 8.

16, “Exhaust Pipe”:
Ungroup the Exhaust Pipe, Create a new material
and pick " drab_concrete.bmp "[image: drab_concrete.jpg]. Select “Roof Junk - Exhause Pipe Base” objects, apply the UVW Map,"cylindrical ", and apply the texture.
Create a new material
and pick "MaxisRoofPipes.bmp "[image: MaxisRoofPipes.jpg]. Select “Roof Junk - Exhause Pipe” objects, apply the UVW Map," cylindrical ", and apply the texture.
Group the Exhaust Pipe again, Clone to 3 copies, move their coordinates as:
Exhaust Pipe X = 4 Y = 27,
Exhaust Pipe01 X = 4 Y = 29,
Exhaust Pipe02 X = -6 Y = 12,
Exhaust Pipe03 X = 6 Y = 10,

[image: 20200120094838.jpg]


▁▂▃▄▅▇(Plus End)

Lighting - Make the Night Yours

So, now we've got a completed building just crying to be exported, but there's one important detail missing. Lighting. You can have the best BAT building in the world, but if it doesn't light at night, it'll be pretty bland, right?
By the time you finish with this page, you should have a general idea of how night lighting works. I will by no means cover each and every single possible topic (again, tutorial would never be finished), but I think this will get you off to a good start. 
[image: light1.jpg]

First thing's first, if you still have the Material Editor open, it may be a good idea to go ahead and close it so it doesn't get in our way. Good. Now, you should be pretty familiar with the above tab for Splines and Geometry, but now we're going to hit the next button, "Lights".
This looks deceptively simple. I mean, after all, there's only 5 buttons. Trust me, it's a little more to it than it looks like, but it's nowhere near as complex as you may think. We'll now explore what the difference between the lights are:
· Target Spot
Well, it's a spot light (begins at a single point and expands as it gets farther away from it's origin). This is great for simulating the light coming from light fixtures, but only effectively illuminates the surface its shining on. As the name implies, this light has a "target", which makes it easy to aim just so. Keep in mind that when creating this light, you have to create the light itself and the target.
· Free Spot
Also a spot light. This one has no "target", however, and simply shines in whatever direction you point it. I never use this one as "Target Spot" is much easier to control.
· Target Direct
Direct light can best be thought of as similar to sun light. Unlike the spot, which starts at a point and expands outward, the direct light is uniform in size. In other words, the illumination area (or "hotspot", explained below) is the same size at it's origin as it is when it ends. Just like the name implies, this one has both the light source and a target. Also, just like the "spots", it's only really effective for illuminating surfaces within it's shaft of light.
· Free Direct
The same as "Target Direct", but has no target.
· Omni
"Fill" lighting. Remember how I said that the spots and direct lights aren't effective at anything but lighting the surfaces they're "aimed" toward? This is the light that does the rest. This one gives a nice "fill" effect to the lighting, illuminating surfaces not touched by the spots or directs. Don't get too carried away with these, else you'll end up with something that looks like it's four inches from the center of the sun at night!
[image: light2.jpg]

Now things start to get a little more complicated. This is the rollout for the lights and has a whole mess of stuff in it! I'll explain what's here as best I can.
1. On Box
If checked, your light will be turned "on" and will render (it shows in the viewports as yellow). If unchecked, your light will be turned "off" and will not render (it shows as black in the viewports).
2. Cast Shadows Box
Will allow your light to cast shadows of the objects they fall on. With it off, no shadows are cast by the particular light this box is unchecked for. With this box unchecked, the light will paradoxically (ooo, I'm using big words) shine through walls, even if they have no opening.
3. RGB Boxes
Allows you to change the color of the light - I haven't got a clue what the HSV boxes do, I've never messed with them.
4. Multiplier
Affects how bright your light is. The default is 1, and you can use decimals. Don't get carried away here, this box will indeed multiply the brightness of the light by whatever's typed in - very easy to make a new star this way (LOL).
(Note that the Affect Surfaces area was skipped - I've never played with it, but it can do interesting things from what I understand).
- The "Spotlight Parameters" area is titled differently depending on the light -
5. Show Cone Box
Will allow the light cone to show, but doesn't work very well (or at all, depending on who you ask) in the SC4 enviroment. Shows for Directs and Spots.
6. Overshoot Box
Allows your light to "overshoot" it's cone. In essence, it will cast light in all directions, regardless of it's "cone". I don't use this box, it does bad things. Shows for Directs and Spots.
7. Hotspot
The brightest part in the center of your light cone/area. Basically, its the evenly-lit area directly underneath a light source. Shows for Directs and Spots.
8. Falloff
How far the light extends beyond the hotspot. This is the area where your light will gradually dim until it fades out. Shows for Directs and Spots.
9. Circle/Rectangle Radio Buttons
The shape of the light. Pretty self-explanitory. Shows for Directs and Spots.
- Skipped Aspect because I never use it. -
10. Projector Map
Allows your light to project a "map", or picture, similar to a movie projector. Shows for Directs, Spots, and Omnis.
11. Target Distance
Will tell you, or let you adjust, how far away from the light source the target is. For "Target" lights, it tells you how far away the target box is. For "Free" lights, it will let you manually type in how far you want the "target" to be.
12. Near and Far Attenuation
Affects how your light fades in and out. Basically, the Far Attenuation is how far the light takes to fade to darkness (similar to the Falloff) and the Near Attenuation is how far it takes the light to obtain full brightness. If you click the "use" box, then gmax will use whatever settings are here, and the "show" box will put a representation in the viewports of what the settings will do. Don't worry if you don't completely understand these, it can take some getting used to.
13. Decay
I wouldn't use this, but if you so chose you can set the light to get brighter the farther away from the source it gets with this.
14. Shadows Parameters
With the "Cast Shadows" box checked, the "On" box here will also be checked. You can also play with the way shadows are cast in this box.

[image: light3.jpg]

Now I'm going to explain the difference between the methods of applying night lighting to your buildings.
Default Night Windows
The same type of night lighting Maxis used on their buildings for SC4. Doesn't look too terribly realistic, unless it's applied to rather small windows/objects. It will only show the texture, although Maxis did include a few different colors with the BAT (Beige, Blue, and Green - found on "Utilities tab >BAT button >Parameters" rollout). Pretty limited in scope, but does, indeed, light up the windows. This is the most basic type of night lighting. To get this to work well, you will need to model each individual pane of glass. (See Vu Burger for an example.)
Mixed Lights/Default Lighting
Gives you a bit more realism. With this method, you can use the night lights discussed above to light vestibules or around the exterior and the default textures for the window panes. Works well for larger models where interior detail is unimportant (and where you've "faked" interior detail with textured rectangles behind the glass). To get this to work well, you will have also had to model each individual pane of glass. (See Vu Med for an example.)
All Night Lighting
Gives you the most realism. With this method of lighting, you will spend much more time on this section of your model, but you will also be able to have more control over your lighting's colors, brightness, and areas affected. This will also allow you to still be able to see inside of the building during the night. This works very well for buildings where all of the windows are transparent, and you've spent a lot of time modelling the contents. For this to work really well, you will have also needed to model interior walls. It is unnecessary to model each pane of glass with this method - a single, large pane of glass within the wall will do nicely. (See Vu Quest for an example.)
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Since I don't think it's necessary to go through modelling the interior walls and such for this tutorial, we're going to use the "mixed" method of night lighting. First, we're going to put a spot light under that front overhang.
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We're now ready to create our first light. Since we're going to place a light underneath the front overhang (it is not necessary to model a fixture as you'd never see it in SC4), pick "Target Spot" under the Lights button. In the front view, click somewhere near the bottom surface of the overhang and drag downward - you'll get something like the picture. When you first click, gmax places the "lamp" wherever you clicked (looks like a cone), and as you drag moves the cube-shaped target downward. When you release the mouse button, the light is created. Notice that the light cone is also visible - the lighter inner circle is the "hotspot" and the darker outer one is the "falloff". The lamp and the target are objects that you can move around indepedent of each other. Take note that no matter where you move the target, the spot will point towards it. You will now have two new objects, "Spot01"and "Spot01.target". Be sure to select the "Spot01" (and not it's target) to change the parameters.
NOTE: When you're placing night lights like this, the default lighting is disabled so that you can see what you're doing. Don't panic when your model turns black, it's supposed to do that. Also, do not use the perspective view to fine-tune your lighting. Trust me, the perspective view will give you a general idea of what it will look like, but only a render will show you more precisely.
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Move "Spot01" and "Spot01.target" until both are approximately centered on the concrete. Now, be sure that the target is sitting inside or just below the concrete's surface (so that the light targets the concrete). Be sure to check Cast Shadows, and change the Hotspot and Falloff as shown. There, see. That wasn't so hard, was it? On to the back door!
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Next, we're going to create the illusion that our light fixture on the back door actually lights up at night. This is actually a two-part process. First, create a Target Direct (note that it's easier to do this in the left or right view). Since we want the light to shine towards the wall so that it casts a circular glow on the wall, click somewhere behind the wall and drag towards the light fixture. Gmax will name the light "Direct01". This will light up the entire model in perspective view! To correct that condition, check cast shadows and change hotspot and falloff as shown. Next, move the target so that it sits on the wall centered within the light fixture (hotkey "H" is very important, it's nearly impossible to pick that tiny little target by clicking in the viewports). Now, move your light source (in the case of directs, the arrow-looking thingy) until it lines up with the target (try to make sure it's pointed directly towards the target) and is approximately at the edge of the concrete.
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Remember I said this would be a two-part process? To finish the illusion that the light fixture is actually lit up, create a new target spot. Place the lamp on the light fixture, and the target on the concrete just in front of the edge of the foundation. Gmax will name this one "Spot02". Why in front and not directly underneath? Because if you shine a spot directly down on a solid object, the only light will be on the object with Cast Shadows turned on. Be sure to check the cast shadows box and change the hotspot and falloff to what I show. It's important to remember to do this, because gmax will remember the hotspot and falloff for the last light you created.
I have no idea what kind of measurements the hotspot and falloff correspond to since they are different for spots and directs. Trust me, after playing with lights for days on end, these will do just nicely.
I'll get a little more in-depth with lighting like this later on (in the advanced tips section).
At this point, add the preface "nitelite" to all of your new lights. This way, they will only be turned on at night. If you don't, then they will always be on, making your model way too dang it bright.
ex. Change "Spot01" to "niteliteSpot01" - gmax will automatically change the name of the target.
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If all of those yellow lines and such for the night lights is going to be in your way, you can go to the Display tab (the screen-looking thing) and check the objects you want to hide. Take note that the model itself will stay dark. We're going to light up the windows the easy way (for now), so click on the Utilities tab (the hammer), click on the BAT button, then expand the Parameters rollout. Under Night Windows, change the drop-down box to "Blue".
Next, select random panes of glass on your model and preface the name with "nite". This tells gmax and SC4 to replace that window texture with the default night lighting texture (in this case, the blue one) instead of the window texture. Take note that when I'm lighting windows like this, if I ever light a window on a corner, I also light the one on the other side of the corner to give the illusion of a "corner office". For this model, I picked 14 windows listed below:
· Windows - Glass
· Windows - Glass02
· Windows - Glass04
· Windows - Glass06
· Windows - Glass07
· Windows - Glass10
· Windows - Glass11
· Windows - Glass12
· Windows - Glass15
· Windows - Glass16
· Windows - Glass20
· Windows - Glass23
· Windows - Glass24
· Windows - Glass26
You might also notice that I lit some windows in groups. This is because I think this building's rooms, for the most part, will be more than one window wide.
You'll also want to change add nite to the front of "Lighting - Back Door".
Now would be an excellent time to save.
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Time for some fun! Make sure the perspective view is the port that's active, click on the Utilities tab, the BAT button, and expand the preview rollout. From here, you can pick what your preview render will look like. You can pick from zooms 1-5, and views from north, south, east, or west (S is the front, N is the back, E and W are the left and right walls). We don't want to really see the detail in this model, we just really want to get an idea what it looks like, so under "Preview", make sure quality is set to low, the view is South, and hit the Day & Night button. You'll get the front view of your building in both day and night renders, something like this:
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You will need to move the night render window to see the day render. Looks pretty good, huh? At this point, you could render all four sides and fine-tune your lighting if you'd like. I think it's going to look fine, so we won't do that (but you can if you want to).

[bookmark: OLE_LINK41][bookmark: OLE_LINK42]We're almost ready to export. If we exported right now, then when you got to the Lot Editor the building would be doing all sorts of "floating" (the box showing the building would be in one place, but the actual model would show somewhere else). Don't worry, we're going to fix it. I don't expect you to do all that modelling for nothing!
▁▂▃▄▅▇(Plus Begin)
When the first time I made this lot as a building with LotEditor, I found that the model's position is weird, I mean the model, when I adjust it's position perfectly in the preview window, but it's actual position is wrong so that the LE can't accomplish the lot, I have to move it to a position with a wrong preview. And when I entered the game, The lot obviously stand on a wrong position, and aslo the night light was a little weird too.
By the help of my good friend(Steve) and read experts’s article about BATing (such as Jasoncw’s), I guess the missed parts here is about LOD Boxes issues, So I write one solution here(3DS MAX+BAT4Max 5 maybe be different), If you have more better way to deal with this, Please correct me if I’m wrong, Thank you!
1, “Unhide All” first, then Use Hot Key “H” to select all of your objects without three LOD objects. 
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2, Goto File > Save Selected > Save it as something else (eg new file name)
3, Open your new file(the Save Selected One), Use The “H” Hot Key to select all of your objects and group them, Move your new group with X = 0 Y = 0 Z = 0, Go to the Utilities Tab>Click BAT button>Click the Parameters menu> Click the “Re-fit LOD’s”>Click the “Reset Lights & Camera”>confirem and close the BAT info window shows when you hit Reset Lights & Cameras, as below:
[image: 20200120111727.jpg][image: 20200120124209.jpg]
If You use the “H” Hot Key to check again, You will found that the LODs and the camera has been recreated again by gmax.

Now I guess it’s a good time to save.
I quote Jasoncw’s words here to explain the LOD(Level of Details): ”When you do a render, it renders the area of the LOD. The LOD is the actual 3d object in the game, while the renders themselves are just 2d pre-rendered images of your BAT. So naturally, when you render your BAT it needs to render the entire area around the LOD. Even if it's empty space, it still needs to render that area.” 
Next Let’s goto the last part of BATing!
▁▂▃▄▅▇(Plus End)





Part 4
Getting It In Game
Exporting, the PM, and the LE
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Well, now, we've got a model all ready to go, but now what? This next part is by far the simplest thing you're going to do in the BAT.
If you haven't already, save the file.
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On the Utilities Tab, pick the BAT button, and on the Export rollout hit the Export button. The default for export is "High", but if you're simply doing a test export to see what it'll look like, you can pick from Medium, Low, and Draft. If you pick anything other than "High", gmax will ask if you're sure.
The next step is to sit back and wait. Or, if you have an extremely large or complex model, you'll wait, and wait, and wait, and wait..... While rendering, the computer can run other processes, but I'd recommend shutting down anything else running. The BAT's renderer can be so picky about things, so I prefer not to take chances. 
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On my computer, this export took about 17 and a half minutes. Yours may take longer, or may take less time, depending on your particular system.

Excellent! Now that you're through with gmax, go ahead and close that program. It may prompt you to save (it always does for me), it's completely up to you whether or not you do that. I have heard that if you save after an export, and then try to change the model later, you'll run into MAJOR problems. I would recommend clicking "no", unless you forgot to save before the export (better to have a few issues than lose all changes, right).
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Now, open up the SC4 Plugin Manager. You'll be presented with a window that looks something like the one above. It's actually a relatively simple interface:
1. The Navigation "Tree"- This is where you'll drag and drop your model. Every single possible type of building is listed here. Wherever you "drop" your model is how it will be defined for SC4 and the LE. If you drop it into "Fire Station", for example, the building will be recognized by SC4 as a fire house and react to it accordingly.
2. The Navigation "Window"- At first, this is where all of your models are listed. This is based on what's in your My Documents >Sim City 4>Plugins folder.
3. The Toolbars (not numbered) - Not actually a whole heck of a lot you can do here. You can change how the information shows in the navigation window, "refresh" the screen (if you added something into the Plugins folder after the PM was opened), and view the PM's settings. You can not actually change the settings (and for good reason - you wouldn't want it to stop working, would you).
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Since BAT Tutorial, Inc is going to be an office, but surely isn't fancy enough for §§§, then we'll need to make it a CO§§. Scroll down the navigation tree until you see "R-C-I >Commercial Office >(CO$)Medium Wealth". Now, find your building (I named mine "tutorial") and drag it into the medium wealth commercial office spot. The PM will pop up with the next screen.
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The Properties Editor allows you to make changes to this building's attributes. Take note that this is the CO window. R, C, I, Landmark, Parks, etc will have different values here depending on what they do. I simply don't have the space to explain them all to you, but if you have a question don't be afraid to ask me. This is a breakdown of what you can do here:
 
Building Value - How much this building is worth in Simoleons.
 
Bulldoze Cost - How much it will cost the city to tear it down.
 
Capacity Satisfied - Actually, pretty complex. This is a pair of values: the first is a hexidecimal code that points to a certain demand or capacity (in this case, CO), the second is how much of that capacity this building satisfies. In the case of this building, the second number is how many people will be employed (this can change depending upon which capacity or demand the hex number points to - check out the Mods section for the hex codes). You can check the box next to "Hex" to display in the hexadecimal format (hex is shown like 0x00000000).
 
Construction Time - How long it will take for the construction crew to finish.
 
Exemplar Name - How you will find your building in the LE - also, the name that will show when you query the building.
 
Flammability - How likely the building is to catch fire (the higher the number, the more likely).
 
MaxFireStage - How long it will take the building, once on fire, to burn completely down (not sure as to how it converts to real-life terms).
 
Pollution at center - How much pollution this building produces broken down by air, water, garbage and radiation, in that order - don't get carried away here!
 
Pollution Radii - The radius of pollution - ie the size of the circle this building will pollute, expressed in "cells".
 
Water/Power Consumed - How much water and power this building uses, I assume it corresponds to the same units the in-game buildings produce, but haven't tested enough to be sure. Do not get too carried away!
 
Worth - If this building is levelled by the robot (or any other disaster) how much it will report to the disaster tally - ie, if you have 1000 here, if you lose the building to a volcano, §1,000 will be added to the disaster total.
 
The little window at the bottom just above the OK button gives you a short description of what the boxes do when you highlight them. Remember that some boxes let you type directly in them, some are drop-down menus, and the rest are lists (you have to hit the "ellipses" button - it looks like it's got 3 dots on it - to change the values). For now, we're just going to change the Exemplar Name to "BAT Tutorial, Inc" (without the quotes) and leave everything else alone. Take note that the PM will assign default values it feels are appropriate for the building based on its volume.
 
The Common Tab lets you assign the building to a Building or Prop Family (it's a lot to explain if you don't know what they are - the help file for the LE should help you with this), Advanced Tab lets you choose what foundation you want on this building, Plugins Tab tells you what plugins this description file depends on (it will usually only be your model, unless you've done some tweaking in the Reader or DatGen), and the General Tab tells you all kinds of stuff that may or may not be important to you. Note that you can make no changes to Plugins and General.
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Once you've made all the changes you'd like to make, hit "OK" and the PM will give you the above window. If you ever want to make changes, you can always come back to the PM, click on the category in the navigation tree, and double-click your description file to make changes. You will not have to re-build the lot or re-export the model for the changes to take effect.
That's it for the PM, so you can go ahead and close it. Next, the Lot Editor. I'm going to explain to you very basically how to put your BAT creation on a lot. If you need to know how to use the LE itself, I'd suggest looking for the guide included with it. It will either be in:
Start >Programs (All Programs in XP)> Maxis SimCity 4 Lot Editor Manual
-or-
C:\Program Files\Maxis\Sim City 4\Lot Editor Manual (HTML document)
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When you open the Lot Editor, you will need to pick a lot to modify. Be careful what you pick here. The lot you pick must be the same type (ie - CO, CS, R, etc) and at least large enough to accommodate your building. The wealth level (ie - §§§, §§, or § is unimportant. I always pick a lot at least a bit bigger than what I'm looking fo)r.
NOTE: If you get into the lot and can't locate your building, double-check to make sure you are in the right type and the lot is definately big enough to accomodate the building. Sometimes, if I can't locate my building, I make the lot way too big for what I'm trying to do just to make sure it's not that the building is out of scale
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To get your building on this lot, first go to the Building tab, click on "Replace Item", find your building and click on it, click "OK", and create your lot as you see fit. Notice I made this one a 2x3 instead of a 3x3 like I said I would? That's a matter of personal preference, but when I looked I thought this building would look better on a smaller lot. Besides, it's my tutorial and I can do what I want. So there. (LOL)
Once you're ready to save, click the "Save As" button (this is very, very important - otherwise you will overwrite whatever lot you picked to begin with). Give it some kind of appropriate name in the "Select Name" box. The LE will automatically give you the type, wealth level, growth stage, and lot size of the lot you originally picked. You can change them to something more appropriate like shown (I like trying to stick with the already established naming scheme - makes everything easier for me, but you can pretty much do whatever you want here as long as its unique).
We're almost done!
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The very last step is to test your lot in the game. I believe this is even more important than getting the perfect-looking lot, or getting that front overhang just so. Nothing in the world is worse (well, there are worse things, but this is an example) than uploading a lot that you say does X, Y, and Z, but it doesn't. This is also part of where the temptation comes to make a ploppable. Ploppables are a dime a dozen, but growables will get noticed. There is absolutely nothing wrong, however, if you make a ploppable version (you may want to look into getting the RCI Plop Mod from ST by RalphaelNinja), but you must test both. What you'll be looking for here is little out of the ordinary things, like the query name isn't right, or the number of jobs is way out of proportion, or things like the circled foundation. In addition, you'll want to make sure that the building turned out like you wanted it to.
Remember how dark everything looked in gmax? It will not quite look the same in SC4. You may notice most (or all) of the textures turned out lighter than you anticipated. I chose some of the textures on purpose to demonstrate this. At this point, you'd probably want to go back to your model and tweak it. Whenever you pick textures, just remember to get it about 2 or sometimes 3 shades darker than you actually want it to look (if you have a high-falutin' program like Fireworks or Photoshop, they can really help with this).
Take note that if you get the lot into the game and find out that something isn't quite right with the model, then it's perfectly OK to change the model and re-export. At least with all the files I've used, the export will overwrite the old one (which means it keeps everything you had originally changed to the description and lot, so no need to recreate them). It would also be a good idea (and I usually do this) to define the model as a park just so I can plop it down in the game before I finalize a lot or descriptions just so that I can see what it looks like.
To take care of the foundation, you have a few choices: go back and make your building a perfect rectangle, create a custom foundation, or make it so the lot doesn't conform to slope (or does it very slightly). I wouldn't want to go back and change the model at all. I've heard nothing but trouble comes out of the foundations (though, I've never tried it). The best (and easiest) solution would be to simply make sure the lot either doesn't conform to slope, or that it doesn't do that very much. See the LE manual for help with that. 
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(In the first export, I had to fix a problem and forgot to change the windows back to blue - sorry if that caused any confusion.) I replaced the a couple of the offending light textures with darker ones. I think it looks a lot better! (In case you're wondering, the corners and window sills were replaced with the same texture that was used on the foundation/roof overhangs - the foundation/roof overhangs were replaced with this texture.)
Of course, this little building doesn't come very near Maxis quality, but it'll get you off to a very good start!
Happy BATting!
Please Note: This texture is not presently available to download... it should be available within a few weeks.
 

Appendix
Tips, Tricks and Troubleshooting
This page will cover a (very limited) few more advanced tips, some time-saving tricks, and a little troubleshooting.
First, the troubleshooting.
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Don't you just hate it when something like this happens? This one is simple, the building was not centered on the origin before it was exported. Simply go back into gmax, center the building (group the whole building and X/Y move it to 0). They get harder, I promise.
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What if in the render, or in the LE and SC4 all you see is something like this sitting on your lot instead of your nice, beautiful building? This one's simple too, the LODs are too small for the model. Refitting LODs in the BAT rollout will fix this one. The difficult ones are coming, I really do promise. 
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If you get something like this, watch out cause your model is done for...
No, just kidding, it can be fixed. Maxis suggested that the above problems could be a lighting rig or LOD problem and suggested that the lighting rig should be deleted, then re-fitted, and the same for the LODs. For me, that didn't work. Instead, I did the following (can be considered a general "fix-all" solution for something really wonky that nobody seems to know what it is):
1. Select your entire model, leaving out any cameras or lights you didn't add;
2. Go to File >Save Selected and give your building a unique name (this is the same as exporting just roof junk);
3. Open a completely clean BAT file (the best way to make sure this happens is close the BAT and re-open);
4. Go to File >Merge and select your building model;
5. Re-export.
Problem solved! Something like this is just like Maxis suggested, an LOD or Lighting/Camera Rig problem. Since it went all buggy for no apparent reason, it's a good idea to start with a clean slate. Note that first, you may want to double-check to make sure you don't have any geometry or splines unexpectedly sticking way out of the model.
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If you export your new skyscraper, and then notice to your dismay that the lights don't seem to go all the way up, it can be heartbreaking. This is usually (not always) a lighting rig problem (ie - the rig isn't big enough for your building). To fix this, delete your current lighting rig by going to File >XRef Scene and removing whatever's there. Next, hit the "Add" and navigate to:
C:\gmax\gamepacks\BAT\scenes\CamLightRigs
There are four lighting rigs - Rig (default), RigMedium, RigBig, and RigHuge. Maxis seemed to indicate that these rigs should accomodate all possible sizes of buildings, but it is possible to create your own (I'm not even going to begin to get into that - check the BAT help files for more information). My suggestion would be that if the huge rig is still too small for your building, then your building will probably cause all kinds of problems in game due to its size. Scale it. 
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Suppose you've gone through all the hard work of creating a building, exporting it, and putting it in the game only to find out it's way out of scale? Or, suppose you want to re-use your gorgeous HVAC unit and turns out it looks way too big on your new building? Select and Scale will help here.
- WARNING -
This becomes very tedious. It's always better to try keeping the correct scale in mind at all times.
The first thing you'd want to do is decide exactly what needs scaling. Does the entire building need to be taller? Shorter? Wider? Or maybe that overhang is too small after all? What you'd want to do is select everything you want to scale (most likely it's going to be the entire building) and group them (not absolutely necessary, but it really helps). Next, you'll need to pick one of the scaling options:
1. Select and Uniform Scale - keeps the object's proportions while scaling - so if you make the building narrower, it will also make it shorter and smaller front to back.
2. Select and Nonuniform Scale - does not keep the proportions - will give it a "stretched" or "squashed" look - whatever you change will be the only scale changed.
3. Select and Squash - seems to do just about what Nonuniform Scale does, but I've never really used it.
Once you have your scaling option selected, and your objects grouped, it's now time to scale! Unfortunately, scaling doesn't seem to be an exact science as shorter buildings in SC4 have been exaggerated to show detail and taller ones have been scaled back so they're not overwhelming (but if you model the way I showed you, this shouldn't be a problem). What you're going to do is type in whatever you want to change in X, Y, and Z. Just like with moving, X will always change left/right, Y front/back, and Z up/down. The numbers in these boxes are percentages, so if you want to increase the height by 10%, then you'd type 110 in the Z box. If you make a mistake, it's easily undone by changing the number back to 100. Just be forewarned, you can spend hours scaling something and still have it turn out wrong. Also, if all you need to change is the building itself and none of it's detailing, you will need to manually move the detailing back to where it should be. See, told ya it can be very tedious.
NOTE: If you change the value for Z, you will have to place the building back on the X/Y plane (2d world), or else you'll lose that part of your model underground!
With enough attention to detail, with just the information I've given, you can model some pretty amazing stuff.
Some tips:
1. Detail, detail, detail - almost every detail you put in will show in the render.
2. Text - for any kind of text to show well at all, it needs to be extruded (just like any other spline) - for something that's "painted on", an extrude of 0.1 or a little less will do nicely.
3. Textures - they need to be at least 2 shades darker than you think they need to be to show like you expect them to.
4. Realistic buildings - avoid faking detail like the plague! Yes, the above model has faked detail, but just like MaxisBrian (I believe it was) suggested, detail should never be added with textures, textures should accentuate the detail.
5. Don't overlook the lot - you can have the bestest BAT building in the whole wide world, but if your lot is grass with a tree or two, people will likely ignore it.
6. Windows - it is OK to place a rectangle behind the glass of a window to give it the illusion something's going on inside - how insane would it be to model every single room of a 55-story office building (note that you can put one huge rectangle behind the glass and use a bitmap with lots of little squares going on)?
7. Window glass - instead of modeling every single pane of glass, why not put one huge rectangle centered in the wall? This is great if you're going to do the night lighting inside modeled rooms, not so handy if you're going to use "nite" to light up the glass.
8. Never release before you're ready - no matter how much other people are pressuring you to release your work, remember that the building and the lot reflect on you. If it's not exactly how you want it, keep working and ignore the beggars! After all, what's most important is that you're happy with it, right?
9. Save often, and in multiple places - you never know when your file will be corrupted or your computer will lock!
10. If you don't know and can't find it, ask - the only way you'll ever know is to ask if you can't find the answer on your own. The only stupid question is the one never asked!
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Now that we're just about finished, a few tricks:
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If you're creating a taller building, like this 20-story office building (well, the wall of one), array is your best friend. Just like when you arrayed the window openings on BAT Tutorial, Inc, you will need to array your windows across. Unlike the tutorial building, however, you will also need to array the windows up. To accomplish this, you'll set your 1D array just like you would if it were only 1 floor, and change the 2D array (make sure to select the radio button) to the number of floors. Note that here, it's only necessary to make the Z for 2D the height of the floors. A few seconds later, you have a wall full of window openings! (After an extrude, of course.)
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Vamos supor que você tenha algo como a figura no canto superior esquerdo, mas vocêLet's suppose that you have something like the upper left-hand picture, but you want it to look more like the night render? You'd need to light it, of course! (I did this one in a bit of a hurry, so it looks like crud - but anyway.) I'm really not going to explain this in explicit detail, but I included a screenie of the settings I used for this particular model. In this model, there are 6 spots and one omni light. Also, if you want shadows to cast onto the ground, you'll need to put something on the ground in the BAT - otherwise no shadows for you!
The lighting above is for example only. Whenever I'm lighting a model, I usually end up playing with the settings and doing test renders over and over. Just remember that for this, unlike the texturing, SC4 has a tendency to make lights darker. That means you'll need the lighting to be a bit brighter than you actually want it to turn out. (For Vu Quest, I think I did about 30 or so test renders, and 4 exports.)
Now, a few tips about editing your splines. 
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Let's say you want a nice, bendy shape like this one? All you have to do is put an edit spline modifier on a spline (like a rectangle), use the selection method of "Vertex" in the edit spline rollout, and move the verticies up.

[image: appendix11.jpg]

If you move those little green boxes around, you can change the curve of the line.

[image: appendix12.jpg]

You can also delete verticies to create interesting shapes. If you delete a vertex, gmax will connect that side between the two verticies that the deleted vertex used to lie in the middle of. Be careful, though. If you delete all of the verticies, they will disappear, but the spline will still be there.

[image: appendix13.jpg]

If you want to create a quick and simple arch (this can be a little tedious if you don't have a good eye for it) you can simply edit the spline. All you have to do is apply an edit spline modifier to the rectangle, and (using the selection method of "Vertex") pick individual verticies to move the green boxes around until you get a pretty good curve out of it.

[image: appendix14.jpg]

Lastly, if you don't want the sides to be curved, but don't want to mess around with changing the curve of the line, an edit mesh modifier is for you. Slap an edit mesh modifier on your spline, choose vertex or face in the rollout, and move until your heart's content. There will be no curvature to the faces, they'll just use the shortest possible distance.

[image: appendix15.jpg]

That looks complicated, don't it? Well, I'll explain it. Let's suppose you wanted to make a roof like what's on top of Vu Med farther up the page. You'd follow these steps:
1. Set Grid and Snap Settings to "Vertex" and "Grid Points".
2. Assuming you already have an extruded rectangle on the roof, snap a pattern of lines like so (note that you have to complete each side - ie, the shapes on all four sides are complete polygons). When you snap that last vertex, window 7 will appear. Click "Yes" so that the shape becomes one poly.
3. Put an edit mesh modifier on each of your roof sides, and you can either use the "Vertex" or "Face" selection method in the edit mesh rollout to move the tops of them up like so.
4. Snap a rectangle into the opening in the top, and move it down a bit. Also, in this step, you'll need to snap rectangles in the empty space between the rooftop and the upper edge of your side roof pieces (4A). For these, the rectangle will be made facing you. So, if you snap the rectangle in the left view, the rectangle will be facing left. So you don't have to go through messy extrudes, simply rotate the rectangle 180 degrees to face the opposite direction. Clone and/or create new rectangles until you have all of the empty space filled.
5. So there's some kind of edging to this roof, snap lines with the Generate Mapping Coords and Display Mesh boxes checked. Note that for this, you only snap the lines where you don't already have one - you don't want them to overlap.
6. SUCCESS! You now have a complex-looking, but pretty simple to make, rooftop for your new buildings.
[image: appendix16.jpg]
Remember when we deleted part of our bend pipe for the back of the HVAC and I said I'd show you how to fill in the empty spaces later? I didn't lie, it just took me awhile to get to it. (Go back to Minute Details if you don't remember about this.)
OK, I took a cylinder, put an edit mesh modifier on it, and using select "Vertex" deleted all but the outer 3 rings. This will leave the back part of the object empty and see-thru. To fix that, you'd need to pick "Edge" selection in the Edit Mesh rollout, and rotate one of your viewports until you can clearly see just the back part of the cylinder (like the picture with the yellow circle on it). Very carefully, select the edge that's over the empty area (it will turn red). Next, in the "Edit Geometry" rollout, change the Extrude to the negative of the height of your shape and hit the Extrude button (ie- if your geometry was 120 meters tall, then the extrude would be -120). Do this for all the remaining edges until the back is filled in.
Remember also that if you fill in the back of the cylinder this way, the back will be one face. This means that if you put a texture on it, it will be stretched across the back face. Just thought I'd warn you so you didn't get the same nasty surprise I got.
When you're done, you will notice some very strange shading on the geometry. Do not worry about this at all, it doesn't show in the render.
Well, I could go on and on and on with tips and tricks, but I suppose that's about it for now. Using all of the methods I've shown you, some pretty impressive buildings should begin to appear on the STEX.
Remember our deal, though, NO DUPLICATES OF BAT TUTORIAL, INC. Please - I don't wanna get in trouble with Grampa Al or dirk.
HAPPY BATTING! [image: :party:]
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Gmax Keyboard Shortcuts
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